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Godex Production Suite 4.6
Disclaimer

Codex products are continually developed to remain at the forefront of the industry, and as such the information in this
guide is subject to change without notice. Whilst Codex endeavours to ensure that all documentation provided is correct at
the time of writing, this document is not guaranteed to be error-free.

Codex does not assume responsibility for issues or losses due to misinterpretation of the information in this document,
errors in this document, or incorrect configuration or installation of the equipment described herein.

This document is issued in conjunction with the software to be used as per the conditions of the associated beta
agreement.

Please report any errors found in this document to support@codex.online
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Welcome to this guide for Codex Production Suite 4.6 - a fully-featured dailies and archiving system featuring
sophisticated tools for colour grading and LUT management, QC, metadata editing and audio sync so you can
manage and create all your deliverables within one unified system. Transcode to all the formats you need to
deliver, faster than real-time, even with an input LUT, CDL and a 3D LUT.

Codex Production Suite 4.6 consists of Vault Platform and Review, and provides a comprehensive feature set
including:

e Support for many popular cameras - ARRI ALEXA/MINI/AMIRA, Codex Action Cam, Canon C700/C500/C300
Mark I, Panasonic VariCam 35 and Pure, Sony F65/F55/F5, RED EPIC/WEAPON, Phantom Flex 4K and
GoPro.

e View, edit and add metadata in the Library.

e Clone camera original data to local storage.

e Primary colour correction - play back, adjust and apply LUTs and CDL looks in Review.

e Synchronise audio, either with timecode or manually.

e Add Quality Control (QC) notes and create PDF QC reports.

e Transcode to formats such as ProRes, DNxHR/HD, DCP and H264 with LUTs, CDL, burn-ins and masks.
e VFS (Virtual File System) for fast, flexible and powerful deliverables creation.

e Framings to allow customisable extraction of ‘region of interest’ from source image into deliverables.

e Archive to disk or LTFS tape with md5 verification.

Codex Production Suite 4.6 can be used on several hardware platforms:

e Codex S-Series (only if running latest CodexOS operating system).
e Codex XL-Series (only if running latest CodexOS operating system).

e Mac Pro running OS X 10.10, 10.11.6+,10.12, or 10.13 (recommended specification: Processor - 3.7GHz
Quad Core Intel Xeon E5, Memory - 32GB 1866MHz DDR3 ECC, Graphics - AMD FirePro D700 6144MB).

e MacBook Pro running OS X 10.10, 10.11.6+, 10.12, or 10.13 (recommended specification: Processor -
2.8GHz Intel Core i7, Memory - 16GB 1600MHz DDR3, Graphics - NVIDIA GeForce GT 750M 2048MB).

Codex Production Suite 4.6 running on Mac OS X supports the following media readers:

e Codex Capture + Transfer Drive Dock (Thunderbolt 3).
e Codex Transfer Drive Dock (Thunderbolt 3).

e Codex Capture Drive Dock (Thunderbolt 2).

e Codex Capture Drive 2.0 Dock (Thunderbolt 2).
e Codex Capture Drive Dock (USB-3).

e Codex Capture Drive Dock (SAS).

e Codex CFast 2.0 Card Reader.

e Sony AXS-CR1.

e Sony SBAC-US30.

e Sony SBAC-UT100.

e REDSTATION REDMINI 1.8”.

Any other card reader supported on Mac OS X can also be used with Codex Production Suite - the list above
details those integrated for use directly with media expressions, which are covered in more detail later in this
guide. For playback to an SDI monitor from Mac, the AJA 04K and AJA T-Tap are supported.
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Please follow the install guide available with software from https:/www.codex.online/software

On Mac go to /Applications/Codex and open the Vault Platform software. On Vault S/XL-Series the login screen
is presented when the system starts. From the login screen there is no password by default so simply click the
Login button.

A password can be set later to restrict access.

A licence is required to use the Codex Production Suite software.
On Mac, first connect your Dock hardware (and for USB3 Docks, insert a Capture Drive).
From the ‘Preferences’->’System’ screen click ‘Request Licence’. On Mac this will open a web browser on a

page where you can request a licence. On Vault S/XL-Series this will present a URL for the webpage where
you can request a licence (https://codex.online/licence-request).

Codex Support will then provide the licence key and activation instructions.

To begin we will discuss the layout of Vault Platform and explain some of the terminology used.

Click the blue ring in the top left corner to open the Main Menu:

Click the blue Codex  — Preferences > System
ring to open Main Menu

:‘[- Project

] Library

am Storage

6‘ Job Queue

-Q- Preferences
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The following options are available:

Project - this is where Codex Production Suite is set up for your project. There are many presets provided
within Project to make the setup process easier. The areas within Project are:

Setup - here you set up Production information, as well as a ‘Project root directory’ - this is a folder that you
regularly want to use for transcoding and archiving to, and appears in the file browser for quick access.
There is also a Project frame rate that should be set correctly for your project. Click the pencil (Edit) icon in
the lower right corner to change the settings:

Cameras - set up details of the cameras/formats that are being used, for example ALEXA 4:3 or

VariCam 35. The purpose of this is that each camera can be associated with a Framing (see below) - for
example you may want to extract the same region of interest from all ALEXA 4:3 clips into files for editorial or
dailies. Optionally, camera settings may even be matched with clips based on specific metadata, such as
camera serial number.

Framings - set up Framings for both Source and Destination. A Source Framing is the ‘region of interest’
from the source clip that you want to be included in deliverable files. A Destination Framing controls the
resolution of the file to be created (scaling), and also how the source image should be fitted.

Deliverables - set up the types of files that are required for post production. For example, a production may
require H264 for iPad dailies, DNxHD MXF for editorial, DPX files for visual effects work, and a RAW image
format for final colour grading and DI.

Jobs - set up templates for the workflow tasks that need to be performed. For example, you may first want to
Clone the data from camera media. Then you may want to Generate files for editorial. Finally you may want
to Archive files to LTFS tape for long term storage. These different tasks can be configured separately, or in
combination, inside your Job templates.

VFS - set up the VFS (Virtual File System) to provide deliverable files inside the ‘Codex VFS’ drive that
appears on the Mac Desktop, or in the ‘codexvfs’ network shared drive on Vault S/XL-Series. Once
configured the VFS provides the files ‘on-demand’ - files for loaded material are always there and ready to
be copied. The folder structure and naming of the files is highly configurable using the VFS.

Library - interact with clips on the system. For example you may select clips in order to start a Job, load
them into Review for playback and primary grading with CDL, or check and edit metadata. You can filter
the clips based on metadata and/or location, and create groups of clips, to help organise your workflow.
There are also useful tools for creating an ALE, timecode correction, and image flip/flop.

Storage - view details for the media that is connected to the system, including camera media and
connected hard drives. The location of the media, available space, and capacity are shown. For Codex
Capture Drives an Erase option is provided. Other devices should be reformatted using Mac Disk Ultility.

Job Queue - view the progress of jobs that are running, as well as pause and stop jobs if required. The
progress bar at the top of the Production Suite software is visible from any screen, and shows details for the
job that is due to complete last.

Preferences - perform operations such as installing a licence, exporting logs, and changing the username
for the software.
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The image below shows the Library with some clips highlighted and the Tools panel open:

Clips Visible/Total Number Selected Metadata
List View ~ Group View Filter On/0ff | Select All/None Clip | Tools
Grid Size

Main Menu B
F“tef HH -1 + O Lotz S B seleced12
Gﬂd ViBW Q ‘ 1-14_AAO01 1-37_AA002 o 1-18_AAD02 1-19_AA002

[0
» ',
j , “ | [ Group from Selection |
. L o
=1 ! 33 Delete Selected Clips:
8! ‘E}i J Resync Linked Clips

Select Clip ] FoY " vcnve o 2. rese) |
g I 5 O coeoe ]

‘ ] Uncooi e |

_senemteanymivemnle(pvm)

Focused Clip
Open Clips in Review Highlighted Clip

Use the Grid View and List View buttons to toggle between two different views of the clips. Grid View shows the
first frame of the clip along with the clip name. If a Poster Frame has been set in Review, this will be the frame
shown in the Library. When in Grid View use the Grid Size slider to adjust the size of clips that are shown.

List View shows the Clip name, Roll, Timecode, Duration, Scene, Take, Camera, Day, Shoot date, Location,
and any Comments:

MacBook-Pro.local 14:54 ﬂ

O 50f5 = [ selected:0

Clip name Timecode Duration

O A025_C007_0604_151132 16:40:22:19 00:00:18:22

O A025_C017_0604_151206 16:44:03:14 00:00:31:17
O A025_C016_0604_151204 16:43:59:06 00:00:04:08
O A025_C013_0604_151149 16:42:23:06 00:00:25:24

Scroll left and right, or expand the Vault Platform Ul, to view all the columns. Click on a column heading to
sort by those values in ascending/descending order. Once the order has been changed in List View, it will be
maintained in the Grid View (until the Vault Platform software is closed).
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There is also a Play View button that allows for quick playback of clips within the Library:

®0e Vault Platform

Alis-MacBook-Pro-2.local 13:22 ﬂ Ready

O 280f28 = B\ selected:0 @ O 0
C713C001_151125E0

Create ALE Fix TC
Flip Flop

Resync Clips

RESOLUTION ANALYSIS CHART

EXR

Link to Clips (preset)

— 3 Gen 1fr EXR cdx and sny
E- 3 By E

£e Generate any Deliverable (preset)

Other Jobs

C L] crororer Jio ] >
[ 1< 18:51:49:18 [ 1 |

There are buttons at the top of the screen to Select All and Select None. To manually select/deselect a clip:

¢ In Grid View click the circle in the top left corner of the clip.
e |n List View click the circle on the left of the clip name.

When starting a job the selected clips will be used. Clips can also be highlighted or focused as shown in the
image above. If one or more clips are highlighted/focused then these will be used for a job, provided that no
clips are selected. If clips are selected this always takes priority over highlighted/focused clips, so in the case
where some clips are selected and some are highlighted/focused, only the selected clips will be used for a
job.

The focused clip has a play icon available on the image tile. Click the play icon to open the highlighted/
focused clips in the Play View. The function of this button can alternatively be set to ‘Launch Review’ from
‘Preferences->System->Library->Play button’.

There are keyboard shortcuts available for highlighting, focusing and selecting clips:

e To focus a clip click on the clip name/image tile.

e To highlight multiple clips, first click to focus a clip then hold Shift and click another clip or use the cursor
keys to move around the grid/list.

e To highlight multiple ranges of clips hold Cmd (Mac) / Ctrl (Vault S-Series) while clicking another clip, then
repeat the previous step.

e When clips are highlighted/focused use the Space bar to select/deselect them.

On Vault S-Series to use an external mouse/keyboard, connect the devices and press Ctrl-T.
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Click the Filter button to open the Filter Panel. By applying a Filter you can control the clips that are displayed
in the Library.

6.6.806 Vault Platform "
Library 15:50:05 Ready A

HH -\ + L 8ofs = [ Selected:0 @ o o

O A009_C004_1102... O A009_C005_1102... O A009_C006_1102... O AD09_CO07_1102... Filter on Media

-— -—

Filter on Source MUL
Filter on Group

Filter on Audio/Video
O A009_C008_1102... O AD09_C009_1102... QO A009_C010_1102... QO A009_CO11_1102...

-— -— -_— -—

Name

Take

Source ID
El
WB

Log Note

Codex Operator
Codex Serial
Codex Version

Director

Clear Filters

O Show Audio Only Clips

The top four options (Filter On: Media, Roll, Group, Audio/Video) provide drop down options for quick filtering.

The rest of the options in the Filter Panel require values to be input to filter on. For example if you want to filter
for every clip that has a metadata value of 800 for Exposure Index, click the El button and type in 800 and
press Enter. If you apply multiple filters then only clips that match all the filters will be displayed.

The wildcard character * can be used to filter for clips that have any value for a particular metadata field. You
can also search using text combined with a wildcard - for example applying a filter on ‘Roll’ for A* will match for
any clips that have Roll metadata beginning with A.

To filter for more than one value in a field, use the & symbol. For example, adding a filter for ShootDate of
Day31&Day32 will result in the Library showing clips that have either the value Day31 or Day32 for ShootDate.

At the bottom of the Filter Panel is the option to Show Audio Only Clips, which is switched off by default. Click
the circle next to this option to turn it on, so that any audio files that have been linked to are displayed in the
Library.

To toggle the Filter settings on and off, use the Filter On/Off button.
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Click the Clip button to open the Clip Panel. The Clip Panel shows information about the focused clip.

0.6.6 Vault Platform o)
16:01:55

el + O 8ofs =, [ Selected:0

O A009_C004_110221... O AD09_C005_110221... O AD09_C006.110221... O A009_C007_110221... O A009_C008_110221...

- e A009_C009_110221_E52P  y e

-

O A00Y_C009_110221... O A009_C010_110221... O AD09_CO11_110221...

-_— -—

AOD9E52P
19:59:07:20 - 19:59:07:21 [00:00:00:01 ] /24

Scene
Take CO09
Source Varicam35 #ESTA00085

Video RAW 10-bit Bayer
4096x2160

Audio
Metadata TC, UB
Shoot Date
Exposure Index 4000
Shutter Angle  180° (1/47s)
CameraFPS 23,976
White Balance 4300
Lens Type
Focal Length
Aperture
Focus Distance

Clip History Oldest on top | Full
Task Name PDF reports (preset)
Timestamp 28 Sep 2015 4:01:16pm
Task Type Media Sign Off
Input  Shot Group: Selection (34)
Task State Completed OK

Important metadata such as Scene, Take, Format, EI, WB, and Shutter Angle is shown, as well as clip duration
in frames (e.g. 1423 fr) and as timecode at the Project frame rate (e.g. [00:00:59:07] / 24).

At the bottom of the Clip Panel the Clip History is shown. This has details of every job that has been performed
on the clip.
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Click the Metadata button to open the Metadata Panel. The Metadata Panel shows metadata information about
a clip (or clips, if more than one is selected) and provides access to the Edit Metadata feature.

[ JOX ) Vault Platform

MacBook-Pro.local 14:49 ﬂ Ready

O A025.C019_0604.....

CodexSerial
CodexVersion
Exposurelndex
MetadataFilename
OriginalFrameRate
OriginalRoll
OriginalShotName
ShotName
ShutterAngle
SourceCreationTime
SourceDatapackGUID
SourceDevice
Sourceld
SourceMUL
SourceSerial
SourceShotUuid
SourceUMID

Take
VideoMediaFilename
VRAW.ClipName
VRAW.GlobalClipID
VRAW.HighSpeed
VRAW.LogEncoding
WhiteBalance

Total Frames

»
Total Size

+ O 50f5 = Bl Selected:0 @ o Q

O A025.C017_0604_....

XXXXX
vrw-3.1.0beta-02868

5000
[Users/alifTestFiles/VariCam/AQ25._...
25.000

A025
A025_C013_0604_151149
A025_C013_0604_151149
180.00

1433414889000
28A6136405000069
Varicam35

A

A025

JATAA0026
d064bed1-b14f-4927-6205-6963845...
(caB9c76-e3a2-4724-b1d2-a9c6969...
C013
[Users/alifTestFiles/VariCam/AQ25._...
A025_C013_0604_151149
060A2B340101010501010D431300...
0]

Full

3200

649 (27 secs / 24) Q‘
8.6 GB

The metadata shown in the Metadata Panel can be changed by selecting from the drop down options:
Filecard, SidePanel, Project. These options can be customised if required.

There is also an All view that shows all metadata stored with the selected clip(s). A summary of the Total
Frames and duration of the highlighted/selected clips is shown at the bottom of the Metadata Panel.

The bottom of the Metadata Panel shows the Total Frames, Total Duration, and Total Size of the selected clips.

To edit the metadata for the highlighted/selected clips, either press the keyboard shortcut E when in the

Library, or open the Metadata side panel and click Edit Metadata.
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In the Edit Metadata area there are several views that can be used. The first two tabs give drop down options,
and default to Project (production details) and Filecard (the most commonly edited items). Click on the Project
or Filecard tab to change the template that is used.

There is an All view that shows every metadata item stored with a clip, and a Clip Info view showing metadata
properties of the clip that generally (but with some exceptions) cannot be edited.

000
Library > Metadata Editor 16:04:38 Ready

Vault Platform

A009_C009_110221_E52P

[N Ely 8 ADD9_C009_110221_E52P

61 AOD9ES2P
Scene
(651Gl 30 Jul 2015 21:48:36
VI LELEE Tt il 4096x2160p@23.98 10-bit Bayer RGB
Pixel Aspect
Audio Format
Timecode RERERI]
11l 00:00:00:01
LUr ) ELn Y 19:59:07:20
DETENNIE VA No CRC32 samples
Poster Frame

Live Look Name

Pre LUT

Load CDL Load ALE Set Source Aperture Close Editor

The lighter coloured fields can be edited, and the darker coloured fields are read-only. The blue fields have
preset options available from a drop-down list.

Click in a field to start editing metadata for a clip. Use the Edit All button or the Cmd-A/Ctrl-A shortcut to
select and make a change to every clip loaded. When the Edit All mode is enabled, any metadata that varies
between the clips is shown as <mixed>. Follow the prompts to Save or Discard changes as required.

Press Esc to leave edit mode if no changes have been made, or to discard any changes that have been made.

To select a clip for editing click on the thumbnails shown at the top of the screen. To move through the clips
click and drag left or right on the thumbnails.

The Clip Info view allows the Pixel Aspect to be adjusted. This can be used for clips recorded with an
anamorphic lens, so that the correct de-squeeze is applied.

Other options available at the bottom of the screen are:

« Load CDL - use this to apply CDL values from a .cdl file to the clips.
+ Load ALE - use this to apply metadata values from an ALE file to the clips.
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+ Set Source Aperture - use this to apply a Source Aperture to the clips (for defining a ‘region of interest’
inside the source image). Once the Source Aperture is set for a clip, this can be used to determine what part
of the image is shown for playback and what part of the image is used when transcoding to other file formats
for post production. To remove a Source Aperture, select the clip(s), click Set Source Aperture, and select
None.

Click the Tools button to open the Tools Panel. The Tools Panel is where you can start a job such as a Clone or
Archive of clips, along with a range of other operations in the following categories:

00606 Vault Platform ")
16:06:40 o Ready A

-\ + O sofs = [, selected:0 @ o o
O A009_C004_1102... (@) AUOQ_CUGEHM... (0] AUW_CUOEHM... O A009_C0071102...

O A009_C008_1102... O AD09_C009_1102... O A009_C0T0_1102...

-— -

Create ALE FixTC

oY Gone o removai res
o ST
& CERITET)
& I

Other Jobs

+ Review - click to load the selected clips for full screen playback, prinmary CDL-based colour grading,
and audio syncing adjustment with an attached HDMI/DVI/SDI monitor. QC notes can be added, and a PDF
report produced using the ‘PDF reports (preset)’ job.

+ Group From Selection - create a Group of clips that can be used for a job. For example, you may want to
create a Group of everything from the same shoot day for archiving together.

+ Delete Selected Clips - delete clips from Codex media, such as a Capture Drive, Capture Drive 2.0, or
Transfer Drive. There is a confirmation prompt that lists the clips that will be deleted, but after this there is
no undo option! If the Link task has been used to add clips to the Library, using the ‘Delete Selected Clips’
button will remove the clip from the Library but will not delete the source file.
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+ TC Sync - sync clips with audio files based on timecode. This option is only available on systems without a
graphics card. On systems with a graphics card this option is not available, and the Audio Sync task can be
used to sync audio and video, followed by Review to check and adjust the sync.

« Create ALE - create an ALE (Avid Log Exchange) file for the selected clips.

« Fix TC - adjust the start timecode for a clip. Numbers can be input without separating colons, and these will
be added automatically.

+ Flip - reverse the vertical orientation of the clip.
« Flop - reverse the horizontal orientation of the clip.

e There are 4 slots here that can be used to start any Job on the system. These default to the first four preset
Jobs on the system. Click the cog icon to set which Job is assigned to which slot.

¢ The Other Jobs button provides access to all the Jobs on the system. For users familiar with Vault 3.0, this
button has replaced Task Scheduler->Manual Jobs.

Click on the Group View icon to see a list of groups stored on the system. One or more groups can be selected
and then a Job can be started. Groups created manually by the user will always be shown at the top of the list,
with the automatically created groups (for example by the ‘Audio Sync’ task) shown below this. In the Tools
Panel the ‘Delete Selected Groups’ button will delete just the details of the selected groups, not the actual
source clips.

[ JOX ) Vault Platform

Alis-MacBook-Pro-2.local 13:34 ﬂ

} 6 Groups E, E," Selected: 0 o Q

Group name Type Status Creation date Clips / Frames
Day1 Library Online 19-Oct-17 13:28 8/721

Day2 Library Online 19-Oct-17 13:28 13/ 10764
Audio Sync Failures 2017/10/19 13:31:19 Task Online 19-Oct-17 13:31 23/11924
Result of Clone from Clone (preset) Temporary  Online 18-Oct-17 16:38 1/74

Result of Link from Link to Clips (preset) Temporary  Online 18-Oct-17 9:54 5/718

Scene56 Timeline Online 19-Oct-17 13:33 11/7763
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There is a column for Group Type, and the types of Group which can be created are:

Library - created by making a selection in the Library and then clicking the ‘Group from Selection’ button
in the Tools panel.

Task - created automatically by a Task, such an Audio Sync task which can create Groups for clips that
have been successfully sync’d and clips that were not successfully sync’d during the task.

Temporary - created automatically by a Task. The title of these groups are in the format ‘Result of <Task>
from <Job>’. For example if the ‘Clone (preset)’ Job is performed from a Capture Drive to a Transfer Drive
a Group will be created called ‘Result of Clone from Clone (preset)’, and this Group refers to the clips that
were copied and stored on the Transfer Drive (the ‘Result’ is the output). These ‘Temporary’ Groups are
removed from the list when the software is restarted.

Timeline - created by using the ‘Group from Timeline’ feature in Review. Clips can be loaded into Review
and the order of clips changed if required, then the ‘Group from Timeline’ button pressed and a name
entered for the group. This Group then appears in the Group View and can be selected for either a per-clip
or combined-clip (timeline) Generate task.

Group status is shown as Online, Offline, or Partially Offline:

+ Online - all clips in the group are loaded, and the group can be used for a Job.

+ Offline - no clips in the group are loaded, and the group cannot be used for a Job.

« Partially Offline - only some clips in the group are loaded, and the group cannot be used for a Job.

When a task is performed on a Group, the Clip History of the clips in the Group is updated. Because this
information is stored in the Group, deleting Groups will also delete the associated Clip History information.

When a clip is being used for a Job a padlock icon may be displayed in the top left corner of the image tile.
This means the clip is locked and metadata cannot be edited at this time:

O AC_EI100_8mm_f2.25_ARRI_mid

Locked Clip icon —
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Codex Production Suite is configured with a range of preset templates for Jobs, Cameras, Framings, and
Deliverables. Here we will discuss how the preset Jobs can be used. For details on how to customise the
setup, including duplicating and editing the presets, see the later Project section.

As a reminder, to start a job go to the Library and select some clips, then open the Tools panel where you can
start the first four preset jobs, or click Other Jobs to start any job on the system.

The preset Jobs available are:

Clone (preset) - copy files from camera media to attached storage, or a Transfer Drive in Vault S/XL-Series.
When this job is started a file browser is shown where you can pick the source and destination for the
Clone. To copy files from camera media, choose the media on the left side of the browser and choose

the destination on the right side of the browser. As each clip is cloned to the destination, the new copy will
show in the Library and can then be used for other Jobs. Note that when Codex media is loaded the clips
will show immediately in the Library and can then be cloned to other storage. Clips on other media must
first be cloned before they appear in the Library, or added to the Library using the Link job (see below).

Link To Clips (preset) - add files to the Library without making a copy of them. When this job is started
a file browser is shown where you can pick a source folder containing clips you want to link to the Library.
(This Link process happens automatically at the end of the Clone task.)

Archive to 2 tapes (preset) - back-up the selected clips to 2 LTFS tapes on Vault S/XL-Series. When this
job is started a screen will appear asking for a name for the archive (e.g. ‘Day 36’, or ‘Rolls BO04-B007’).

Archive to 2 disks (preset) - back-up the selected clips to 2 disk locations. When this job is started a
screen will appear asking for a name for the archive (e.g. ‘Day 36’, or ‘Rolls BO04-B007’), the names of
the disks being used (e.g. ‘Backup Disk 1" and ‘Backup Disk 2’), and also the destination to use for each
backup. Click the ‘... button to open a file browser and set each back-up destination.

Media Check (preset) - get a summary of the selected media (number of clips, frames, clip format). Also
this job can be used to Apply Project Defaults information to clips (from Project->Setup), and to Apply
Camera Settings, which can automatically set a Source Aperture (region of interest) in the clip based on the
Cameras that have been defined.

Generate any Deliverable (preset) - generate any of the available deliverables to an attached disk. When
this job is started the user can pick from any setting defined in Project->Deliverables.

Generate ProRes 422LT (preset) - generate ProRes 422LT deliverables at 2048 x 1080 resolution to an
attached disk.

Generate DNxHD115 (preset) - generate DNxHD115 deliverables at 1920 x 1080 resolution to an attached
disk.

Generate 10-bit RGB DPX (preset) - generate 10-bit RGB DPX deliverables at 4096 x 2160 resolution to an
attached disk.

PDF reports (preset) - save PDF reports for the selected clips. There are 2 types of PDF report that can
be saved. The Clip Report contains a summary of details for every selected clip. The QC Report contains
details of any QC notes made in Review.

Audio Sync (preset) - sync the selected video clips with audio files based on timecode. If both video and
audio are selected in the Library, these files will be compared for sync. If only video clips are selected a
browser will be shown where the location of audio files can be chosen. If there is an ‘audio’ folder containing
BWEF files in the same location as the video clip folders, these files will be used by default. After using this
task, the sync can be checked and adjusted in Review.
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The File Browser is used to select sources and destinations for different tasks. In the case where only a source
is needed (e.g. Link), it appears as below:

[ JOX ) Vault Platform

Job: Link to Clips (preset) MacBook-Pro.local 15:23 p’

Source

A Alastair Nicholls Home @

B Backups
B Demo
B Servers

B shared Backups
Macintosh HD (System Root) mmo /Volumes/Demo/Projects/Example/Backups

JA\ Alastair Nicholls Home
ﬁ /Users/ali

[ Demo
== /Volumes/Demo (hfs) 70.1/512GB

Servers
wmo /Network/Servers

shared
mmo /Volumes/shared

] Macintosh HD (System Root)
/

Minimise
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In the case where both a source and destination is needed (e.g. Clone), it appears as below:

[ JOX ) Vault Platform

Job: Clone (preset) MacBook-Pro.local 15:25 p’
Source Destination

A Alastair Nicholls Home @ w B A Alastair Nicholls Home

Codex CD1-USB 1 B CodexCD1-USB 1
B Backups JA\ Alastair Nicholls Home B Backups
= /Users/ali —

B Demo B pemo

B servers B Codex CD1-USB 1 B Servers

B shared AODTREYR B shared

Macintosh HD (System ... Backups Macintosh HD (System Root)
= /Volumes/Demo/Projects/Example/Backups

Demo
mmn /Volumes/Demo (hfs)

RERES
wmo /Network/Servers

shared
mmo /Volumes/shared

/ Macintosh HD (System Root)
/

Minimise

The left hand panel contains a tree view that can be used to navigate through the filesystem. The central panel
is where the source is selected, and right hand panel is where the destination is selected.

The users Home directory is shown at the top level of the File Browser, along with any attached volumes.
As you navigate down through folders, a ‘breadcrumb’ trail is shown at the top, which can be used to navigate
back up to higher level folder.

You can mark any folder as a Favourite, by navigating to it and selecting the star symbol. Any folders marked

as a Favourite will always appear at the top level of the file browser, and in the left and right hand panels. To
remove the Favourite tag from a folder, navigate to it and deselect the star symbol.
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The image below shows the Storage screen:

20:10:42 o "

L ]

Volumes @

Volume [ Type Free Space Volume Detalls: MS-DOS FAT32 32.34 GB

5001C004 ExFAT AXSM

Untitled 1 MS-D0S FAT32 SxS Mounted
ADO1R0OZ3 UDF Thunderboit data pack Mounted
A003_0101LD MS-DOS FAT32 /Volumes/AD03_0101LD Mounted .

Promisae RAID Journaled HFS+ Volumes/Promise RAID Mounted -

| N NN R

stick MS-D0S FAT32 /Volumes/stick Maounted

The Volumes tab shows each loaded storage media (camera media, hard drive, LTFS tape) with details of the
filesystem type, location, and space remaining. Select media and click the wrench to Eject.

The Devices tab shows attached devices, such as ports, media readers, and tape drives, and can be used to
Load or Eject media by clicking the wrench. Codex media can be reformatted using the ‘Erase’ and ‘Create’
options - WARNING: there is no undo option after reformatting.

A new volume can be created on a Capture Drive or Transfer Drive. To do this, go to the Devices tab and
select the device (click Wrench->Load first if required). Then click Wrench->Create and a dialog is shown:

Create Warning

Are you sure you want to create a new volume on Codex TD
1?

(\Elglsl TD004

13758 RAID-3 Codex -

Cancel
RAID-3 Codex
RAID-5 XFS
RAID-5 exFAT

Enter a Name for the volume and choose a Type.

Capture Drives can be formatted with RAID-0 or RAID-1 Codex filesystem (CFS). However, it is typically
recommended to Erase a Capture Drive in Production Suite and then perform formatting in-camera to create a
new volume. This is because the camera will manage the volume names to avoid repeating Reel numbers.

A Capture Drive formatted in camera for RAW recording (ALEXA, C700, VariCam) will be formatted as CFS.

Transfer Drives can be formatted with RAID-3 Codex, RAID-5 XFS (Linux only), or RAID-5 exFAT filesystem.
The choice of filesystem depends on the following:
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e |f working exclusively with CFS Capture Drives then a Transfer Drive can be used as RAID-3 Codex. A
Transfer Drive formatted in this way can be used as a destination for a Clone, but not as a destination for
other types of task such as Generate or Archive.

e |f working with a mix of camera media, or if you want to use the Transfer Drive as a destination for tasks
such as Clone, Generate, and Archive, then format as RAID-5 exFAT. This filesystem is compatible with
Mac and Codex XL/S-Series (which run a version of Linux).

e [f working with a mix of camera media, and only working with Codex XL/S-Series, then XFS may be used. A
Transfer Drive formatted with RAID-5 XFS is not Mac-compatible.

When a RAID-5 exFAT or XFS filesystem is created, it can be used immediately but the parity information takes
several hours to build. During this time, the status in Storage -> Volumes will be shown as ‘Initialising’. When
the initialising process has completed then a problem with one disk will not compromise the data on the RAID.
For this reason, it is recommended to allow the RAID to finish initialising before copying data to it.

WARNING: Do not move a Transfer Drive between Mac and Linux during the ‘Initialising’ phase, as this
may affect the integrity of the RAID filesystem.

A Capture Drive or Transfer Drive can be erased from within Production Suite. Supported camera media such
as RED MAG, SxS, CFast can also be erased. For other types of storage or camera media, normal erase/
reformatting should be done (for example in-camera, or using Mac Disk Utility).

To erase media, select the Device and then click Wrench->Erase, and Confirm. A dialog is shown:

Erase Warning

Are you sure you want to erase Codex CD1 - Port 2?
This action cannot be undone.

Yes

Click 'Yes’ to proceed with the erase, or click ‘No’ to cancel.

Capture Drives with a Codex filesystem (CFS) will be cleared and no new volume will be created. Capture
Drives with another filesystem (e.g. UDF or exFAT), and other supported camera media, will be erased and
a new FAT volume called ‘BLANK’ will be created. Both these methods are used so that when the media is
loaded back into camera, the user will be prompted to format it.

Transfer Drives will be erased and no new volume will be created by default. When erasing an exFAT Transfer
Drive a warning will be shown if the drive contains any files that were not created during a Clone. This is
because files written to exFAT Transfer Drive with other methods (e.g. Generate, Archive, or Finder copy) may
not be visible in the Library.

For Capture Drives and solid-state disk (SSD) Transfer Drives there is also a ‘Secure Erase’ option. This will

erase the device at a low level, completely removing any data it contains. No new volume is created in any
case when this option is used.
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The Project area is where you configure Codex Production Suite for your workflow. In the Project area you can:

e |nput production information (Production Name, Director, etc.) from the Setup screen, which can be applied
to source clips using the Media Check task.

e Set up Cameras, so that a Source Aperture (region of interest) can be applied automatically to source clips
using the Media Check task.

e Set up Framings to determine the ‘region of interest’ in source clips, and how this is fitted into your
deliverables.

e Set up the different types of Deliverables required for dailies, editorial, VFX, etc.
e Set up Jobs which contain the tasks you need to run for your workflow.
e Set up the VFS (Virtual File System) to provide the file types and folder structure required.

Most screens of the Project area have a list of presets on the left. You can use the + button to add your own
settings, or duplicate existing settings. The pencil icon, shown in various places, allows editing of the settings:

[ JOX ) Vault Platform

Project > Setup AliMBP

Cameras Framing Deliverables

Production name
Production company
Production unit
Director
Cinematographer
Location

Codex operator
Clip naming rule

Project framerate

Project root directory

Project settings

The Setup screen is where you can input production details. This can be applied as metadata to clips during a
Media Check task with the ‘Apply Project Defaults’ button.

CODEX USER GUIDE - 10.11.2017



You can set the Project frame rate, which can be applied to any Deliverable. The Project frame rate also
controls the frame rate of audio files that are linked into the Library, so it is important to set the Project frame
rate correctly.

Set the Project root directory as the default location that you want to use for jobs such as Generate or Archive
- this might be an attached RAID or network storage location. When the file browser is opened a folder marked
with ‘P” will be shown which is a shortcut to this location.

The ‘Import’ and ‘Export’ options allow import and export of all the settings in the Project area (Setup/Cameras/

Framing/Deliverables/Jobs/VFS) in a single XML file. This can be used to switch settings on a machine, or
move them between machines.

[ JOX ) Vault Platform

Project > Cameras

@ Setup Framing Deliverables

Camera Configurations f‘

Camera Name ALEXA 3.2K
ALEXA 3.2K

ALEXA 4:3 Cropped Matching Rules

ALEXA 65 4K Source Width 3168 Height 1778
ALEXA 65 5K Pixel Aspect Square <
ALEXA 65 6.5K Metadata

ALEXA Open Gate

AMIRA 2K Camera Defaults

AMIRA 3.2K Source Aperture  None

Canon C300mk2 4K

Canon C300mk2 UHD

Canon C500 4K

Canon C500 UHD

Codex ActionCam

GoPro 4K

RED 5K

RED 6K

RED 8K
AV -+

There are a range of preset Camera Configurations available, but you can also add your own as required. The
preset Cameras Configurations need to be edited by adding the relevant Source Aperture (region of interest)
for your production.

The purpose of defining a Camera Configuration is because you want to automatically assign a Source
Aperture to any clips on the system that match a particular resolution and, optionally, pixel aspect and
metadata value. For example, you may want to perform the same 2.39 extraction on all 4K clips. Or on a multi-
camera shoot you may want to perform a particular extraction on one camera, and a different extraction on the
other, based on the camera serial number.

Once a Camera Configuration is defined it can be applied to clips during a Media Check task, using the ‘Apply
Camera Settings’ button.
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Project > Framing

e

Framing Templates
4K DCI

UHD

2K DCI

HD

HD 720

4K DCI source
UHD source

UHD (x1.3) source
2K DCI source

HD source

HD (x1.3) source

HD 720 source

ALEXA 16:9 (x1.3)

ALEXA 16:9 (x2)
ALEXA 16:9
ALEXA 4:3 (x1.3)

ALEXA 4:3 (x2)

Vault Platform

Cameras Framing Deliverables

Canvas Name

Type
Description
Width

Pixel Aspect

Aperture Name

Description

Width

Left Offset
Fit mode
H Bias

Crop Source

4K DCI

Destination

Height 2160

-

Height 2160
(0] Top Offset 0
Fit Width and Height -

0.5 V Bias 0.5

-

AV -+

The Framing screen contains presets to cover the most common requirements. The left panel shows the full list
of Framing Templates.

Framing Templates marked with an ‘S’ are Source templates, and can be applied to a clip. These are used to
specify the region of interest you want to crop out of the original image. A Source Framing Template can be
used with a Camera Configuration and applied with a Media Check Job->Apply Camera Settings, or from the
Library->Metadata Panel->Edit Metadata->Set Source Aperture.

Framing Templates marked with a ‘D’ are Destination templates, and can be applied to a Deliverables. These
are used to specify the resolution of the Deliverable, and whether the source image fills the whole Deliverable
area, or whether some ‘safe area’ is left around the outside.

Source and Destination Framings can have a Pixel Aspect set. A Source Framing can only be applied to

a clip that has the same Pixel Aspect. For Destination Framings, the Pixel Aspect determines if the image

is squeezed when the Deliverable is created. For example, if a Deliverable is created using a Destination
Framing with Pixel Aspect set to Anamorphic 2:1, the image content will be horizontally squeezed by a factor
of 2, and is expected to be de-squeezed by the same factor in post production software.

From the Framing screen, there are a range of additional presets for ARRI and RED cameras that can be
accessed by clicking on Wrench->Import XML. This will show a browser with folders for different camera
formats, and these contain additional framing presets that can be imported by selecting one or more of the
XML files.
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Click the + icon to Add a Framing. Enter a descriptive Canvas Name and then set the Type as either Source or
Destination. The settings then available depend on the Type selected.

When setting up a Framing template, the contents of the Description fields do not appear anywhere else in the
software, but can be used to record information about the Framing preset you are creating for reference later.

Settings for Source Framings

Width and Height (of Canvas) - these must be set correctly to match the resolution of the clips that you want
to apply the framing to.

Pixel Aspect - this must be set correctly to match the Pixel Aspect of the clips that you want to apply the
framing to.

Aperture Name - enter a name for the region of interest that you want to extract from the source clip.

Width and Height (of Aperture) - enter the resolution of the region of interest that you want to extract from the
source clip.

Left Offset and Top Offset - the region of interest will default to the top-left of the source image. To centre this
region, click the symbol of four arrows next to the Top Offset box. Alternately, enter values for the Left Offset
and Top Offset manually.

Settings for Destination Framings

Width and Height (of Canvas) - set these values to determine the resolution of the Deliverable file that will be
created.

Pixel Aspect - set this to determine the squeeze factor applied to the source image when the Deliverable file
is created. Deliverables such as .mov and .exr will contain this as metadata, allowing other applications to
automatically apply the correct de-squeeze.

Aperture Name - enter a name for the area within the Deliverable that the source image will be fitted into.

Width and Height (of Aperture) - enter the resolution for the area within the Deliverable that the source image
will be fitted into.

Left Offset and Top Offset - the source image will default to the top-left of the Deliverable area. To center the
source image in the Deliverable, click the symbol of four arrows next to the Top Offset box. Alternately, enter
values for the Left Offset and Top Offset manually.

Fit Mode - there are several options to determine how the source image is fitted into the Deliverable:

+ Fit Width and Height - the whole source image will be scaled to fit into the width/height of the defined
Aperture size. None of the source image will be cropped (apart from the area outside any Source Aperture
that has been applied to the source clip).

+ Fit Width - the source image will be scaled until the width matches the defined Aperture width. Any of the
source image above/below the Aperture area will be cropped if Crop Source is set to Yes.

+ Fit Height - the source image will be scaled until the height matches the defined Aperture height. Any of the
source image left/right of the Aperture area will be cropped if Crop Source is set to Yes.

« Fill - the source image will be scaled until the whole Aperture area is filled. This will result in the cropping
of either the top/bottom or left/right of the source image if Crop Source is set to Yes, depending on the
relative aspect ratios of the source image and Aperture it is being fitted to.
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Crop Source:

+ Yes - this setting will crop the source image to fit the Aperture area, based on the Fit Mode that is selected.

+ No - this setting will result in the source image being scaled and fitted into the Aperture area based on the
Fit Mode, but a crop will not be applied, so the source image may extend outside of the Aperture area.

Vault Platform

Deliverables

Project > Deliverables

@ Cameras

Framing

Deliverable Templates
Camera negative

DNxHD115 (1920x1080)

DPX 10-bit RGB (4096x2160)

H264 (1280x720)

ProRes 422 LT (2048x1080)

ProRes 4444 (4096x2160)

/4

Template name
File type
Lut

Destination aperture

Source region
FPS

Burn-in

Roll transform
Colour space
Type
Compression
Processing

ARRIRAW

DNxHD115 (1920x1080)

mxf

HD > Avid safety (16:9)

Aperture

Original
codex235.xml

None

Camera Native
DNxHD

DNxHD 115/120/145
High quality

Codex

The Deliverables screen is where you define the different types of files required for your project. For example,
you may need to deliver H.264 files with a LUT for iPad dailies, Avid DNxHD 115 with no LUT for editorial,
Open EXR files for visual effects work, and a RAW file type for final colour grading.

Once a Deliverable is configured it, the files are created using a Generate job, or the VFS.

There are a range of presets that provide examples of how to set up a Deliverable:

- Camera Negative - this preset uses the ‘Camera Negative’ file type, and provides the source material in
the original format. For example, ARRIRAW material will be provided as .ari files, VariCam 35 material will be
provided as .vrw files, Codex Action Cam material will be provided as .cdx files.

- DPX 10-bit RGB (4096 x 2160) - this preset uses the DPX file type, and is configured to provide 10-bit RGB
DPX files. The ‘4K DCI> All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No
LUT or burn-in is applied.

+ H264 (1280 x 720p) - this preset uses the H.264 file type. The ‘HD 720 > All' aperture is used, meaning that
all source material is scaled to 1280 x 720. No LUT or burn-in is applied.
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DNxHD115 (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 115 files.
The ‘HD > Avid safety 16:9" aperture is used, meaning that the files will be 1920 x 1080 resolution, and the
source image will be scaled to 1888 x 1062 inside this (the remainder of the image area is black). An
example burn-in is applied that includes roll and clip name, masking, timecode, and a logo.

DNxHD175X (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 175
files. The 'HD > All' aperture is used, meaning that the files will be 1920 x 1080 resolution. No LUT
or burn-in is applied.

DNxHD444 (1920 x 1080) - this preset uses the mxf file type, and is configured to provide DNxHD 444
files. The 'HD > All' aperture is used, meaning that the files will be 1920 x 1080 resolution. No LUT
or burn-in is applied.

ProRes 4444 (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 4444
files. The '4K DCI > All' aperture is used, meaning that all source material is scaled to 4096 x 2160. No LUT
or burn-in is applied.

ProRes 422 LT (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 422
LT files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080. The
LUT is set as {CDLData}, meaning that if a clip has a CDL look stored in metadata then this will be applied.

ProRes 422 HQ (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 422
HQ files. The ‘2K DCI > All’ aperture is used, meaning that all source material is scaled to 2048 x 1080. No
LUT or burn-in is applied.

ProRes 422 HQ (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 422
HQ files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No
LUT or burn-in is applied.

ProRes 4444 (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes 4444
files. The '2K DCI > Al aperture is used, meaning that all source material is scaled to 2048 x 1080. No
LUT or burn-in is applied.

ProRes 4444 (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes 4444
files. The ‘4K DCI > All’ aperture is used, meaning that all source material is scaled to 4096 x 2160. No
LUT or burn-in is applied.

ProRes 4444 XQ (2048 x 1080) - this preset uses the mov file type, and is configured to provide ProRes
4444 XQ files. The ‘2K DCI > All' aperture is used, meaning that all source material is scaled to 2048 x 1080.
No LUT or burn-in is applied.

ProRes 4444 XQ (4096 x 2160) - this preset uses the mov file type, and is configured to provide ProRes
4444 XQ files. The ‘4K DCI > All' aperture is used, meaning that all source material is scaled to 4096 x 2160.
No LUT or burn-in is applied.

Some of these Deliverables are used in the preset Jobs, and some are in the preset VFS templates. Click the
+ icon to Duplicate one of these Deliverables and customise it for your own use, or use the details in the next
section to Add and configure a Deliverable.

Click the + icon to Add a Deliverable. Enter a descriptive Template name and then select a File type from the
drop down list. The available file types are:

Camera negative - provides the source material in the original format. For example, ARRIRAW material
will be provided as .ari files, VariCam 35 material will be provided as .vrw files, Codex Action Cam material
will be provided as .cdx files.

dpx - transcodes source material to DPX format. Files can be output as 10-bit, 12-bit, 12-bit Legacy (for
Resolve) or 16-bit RGB.

jpg - transcodes source material to JPG format.

ari - provides ARRIRAW material as ARl files. This file type can only be output from ARRIRAW source
material.

rmf - provides Canon Cinema RAW material as RMF files. This file type can only be output from Canon
Cinema RAW source material.

vrw - provides Panasonic VariCam RAW material as VRW files. This file type can only be output from
Panasonic VariCam RAW source material

cdx - provides Codex Action Cam RAW material as CDX files. This file type can only be output from Codex
Action Cam RAW source material

exr - transcodes source material to OpenEXR format. This file type is typically output in ACES colourspace,
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and is compatible with source material in the following formats: ARRIRAW, ARRI ProRes, RED, GoPro,
Phantom, Sony RAW, Panasonic RAW. The ‘Type’ setting determines whether any compression is applied
- the None option applies no compression, and the ZIP (per scanline), ZIP (16 scanline blocks), and PIZ
(wavelet compression) apply different types of compression.

H264 - transcodes source material to H264 format. The files can be created at 720p, 1080p, UHD or 4K
with 1 or 2 channels of audio. The 720p/1080p options are compatible with the PIX online dailies system.
mov - franscodes source material to Quicktime MOV format. The files can be compressed with a range of
ProRes, DNxHD, Motion JPEG, or Photo JPEG codec options.

mxf - transcodes source material to Avid MXF format. The files can be compressed with a range of DNxHD
and DNxHR codec options.

DCP - transcodes source material to DCP format. The files can be compressed with DCI or IMF settings.
When using DCI, then additional options are available for Conformity (InterOp/SMPTE), Encryption, and
Audio Layout (5.1, 5.1 HI/VIN, 7.1 SDDS, 7.1 DS, and Wild Track Format).

wav - outputs audio from the source material in WAV format (no timecode or other metadata). Audio is
output as stereo files, so for example if the source clip has 4 audio channels, then 2 wav files will be
output.

BWEF - outputs audio from the source material in Broadcast WAV format (including timecode and reel
metadata). Audio is output as stereo files, so for example if the source clip has 4 audio channels, then 2
wav files will be output.

CodexShot xml - outputs a Codex format metadata xml per clip.

VRAW Metadata xml - outputs a Panasonic format metadata xml per clip from VRAW material.

VLT 3DLUT - outputs a Panasonic format 3D LUT per clip from VRAW material.

Canon xml - outputs a Canon format metadata xml per clip from Canon Cinema RAW material.

FinalCut xml - outputs a FinalCut 7 compatible metadata xml per clip.

Metadata txt - outputs a text file with a timecode entry for each frame in the clip, along with metadata from
Canon cameras.

ASC CCC xml - outputs an ASC CCC xml containing CDL data for multiple clips.

ASC CDL xml - outputs an ASC CDL xml containing CDL data, with one xml file per clip.

cine - provides Phantom RAW material as a CINE file, where there is one file per clip. This file type can
only be output from Phantom RAW source material

ALE - outputs an ALE (Avid Log Exchange) containing metadata for all selected clips.

The settings available depend on the file type selected.
When setting a LUT, the following options are available from the Add button:

LUT - this option allows the selection of a LUT file from the computer. See details below about how to
automate selection of ALEXA LUTs based on the Exposure Index of the clip being processed. A .spimtx file
can be selected to apply to DXL camera material.

+ CDL - this option will apply a look based on CDL metadata that is stored with the clip.

Pre/CDL/Post - this option will apply the Pre LUT, CDL, and Post LUT that can be set on the clip using
Review.

« Camera Look - this option will apply any embedded look data that was set in the camera from ALEXA
ARRIRAW or VariCam 35 VRAW.

More than one LUT or colour transform can be applied. For example, if you require CDL, plus a 3D LUT, plus a
range adjustment LUT, these can be added in turn so that the contents of the Lut field looks something like:

{CDLData}; arri/arri.logC.rec709.E11000.ee.3d.lut; range_EL.lut

When using the Add Lut button there are a range of preset LUTs for different camera systems. The presets are
mostly 3D LUTs that perform a camera log to Rec.709 conversion. An example LUT file name is:
‘arri.logc.rec709.E11000.ee.3d.Iut’, and the file name describes:
<Camera>.<SourceColourspace>.<TargetColourspace>.<Exposurelndex>.<Range>.<LutType>.ext.

The Range of ‘ee’ indicates Extended range (black=0, white=1024 in output file) while ‘el’ indicates Legal
range (black=64, white=940 in output file).

Where a set of LUTs are provided for a range of exposures you can configure the system to select the correct
LUT based on the exposure of the clip. First select a LUT from the set provided. Then, in the LUT field edit the
name so that the exposure value is replaced with the metadata tag {Exposurelndex}, e.g. arri/arri.logC.rec709.
El{Exposurelndex}.ee.3d.lut. This means that for every clip, the correct LUT will be applied based on the
Exposurelndex value in the clip metadata.
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To use custom LUTs click the Add->LUT button and navigate to the LUT file using the browser. Custom LUTs
can be installed in /Library/Application Support/Codex/luts on OS X, or /etc/codex/luts on Vault S/XL-Series,
which is the default location for the browser when using the Add->LUT button.

The Destination aperture setting determines the size of the file that will be created, and whether the source
image is fitted fully into this, or whether the source image only fills a portion of the total image area. See the
additional guide ‘Using Framings In Vault Platform’ for more information and examples.

The Source region setting controls whether the whole source image (Full canvas) or only the area set by the
Source aperture (Aperture) is included in the created files.

The FPS setting can be used to force all created files to a particular frame rate. The Original setting will create
files at the same frame rate as the source clips. The Project setting will create files at the frame rate set in
Project->Setup->Project framerate.

The Burn-in setting can be used to apply metadata overlays on the created files. Choose Burn-in->Add and
select from the preset templates of metadata to add. The template names indicate the metadata that will

be added and the position on the image. You can repeat the process to add multiple metadata overlays to
different parts of the image.

The Roll transform setting can be used to add a channel ID to the beginning (Prepend chan ID) or end
(Append chan ID) of the Roll number in the metadata of the files that are created. This is mainly used for dual-
camera/stereo recordings on Codex recorders, but can be used on any clip that has metadata for ‘ChannellD_
V1’ or ‘ChannellD_V2'.

The Colour space of many available file types can be either Camera Native, ACEScc, or ACEScct. Open EXR
files can be created in ACES linear, ALEXA Wide Gamut (for ARRIRAW clips only), or DRAGONCcolor (for RED
clips only). Supported formats are: ARRIRAW, ARRI ProRes, RED, GoPro, Phantom, Sony RAW, Panasonic
RAW. When ACEScc/ACEScct/ACES is selected the software will apply an IDT to take the image into this
colour space. IDTs are built into the software for many of the supported camera formats. If the files cannot be
generated in ACES colourspace this means there is not a built in IDT for the selected camera format.

The Processing setting determines the quality of scaling, colour conversion, and Codex debayering
operations. It is recommended to set this to ‘High quality’ to get the best result. Different scaling filters are used
depending on the setting:

+ High quality - Lanczos, optimal Codex debayer.

+ Medium quality - Mitchell, optimal Codex debayer unless the file created is less than half the resolution of
the source clip, in which case a lower quality Codex debayer is used.

+ Low quality - Cubic, optimal Codex debayer unless the file created is less than half the resolution of the
source clip, in which case a half-scale Codex debayer is used.

The ARRIRAW and Sony Debayer settings can be used to select the manufacturers debayer algorithm
instead of the Codex debayer algorithm for ‘exr’, ‘dpx’, ‘mov’ and ‘mxf’ file types.

The Sharpening setting can be used to apply sharpening (via an unsharp mask) to image file types, with
values from 0-300.

The Audio Channel Map setting can be used to remap audio channels from the source material into the output
file. For example, if the source file contains 4 audio channels (Mixdown, Boom L, Boom R, Room), and you
want channel 1 only (Mixdown) to be used in channels 1 and 2 of the output file for dailies, you would specify
the Audio Channel Map as:

11,2

Or to remap channel 1 to output 1 and 2, and channel 2 to output 3 and 4, you would specify 1:1,2;2:3,4
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[ NON ) Vault Platform

Project > Jobs 14:41

@ Cameras Framing Deliverables VFS

Job Templates
Name Generate ProRes 422LT (preset)

Archive to 2 disks (preset
© et

@ Clone (preset)

Link to Clips (preset
® Ps (P ) Generate Generate

Generate any Deliverable (preset
® v (prese) From {MediaPort} = "*"

@® Generate 10-bit RGB DPX (preset) )
Deliverable ProRes 422 LT (2048x1080)

@ Generate DNxHD115 (preset) e
Predefine directory No

@ Generate ProRes 422LT (preset) "

Base directory {Roll}/

Media Check (preset
® ® ) Video filename Default

PDF reports (preset
© g P ) Stereo filename Default

Audio Sync (preset
® yne (p ) First frame 0
Number of frames All

Eject external media Prompt

The Jobs screen is where you define templates containing the tasks required for your workflow. There are a
range of presets, covered in the earlier Preset Jobs section.

Click the + icon below the list of Job Templates to Add a Job. Enter a descriptive Template name for the Job
and then click the + icon below to add one or more tasks. The settings available depend on the task type
selected, and are covered in the next sections.

A Job contains one or more tasks that can either run in sequence or in parallel depending on how the template
is set up.

The Start of the Job can be set to Manual and/or Automatic. When set to Manual, the Job must be started from
the Library.

When set to Automatic, the Job will start when media is loaded into the port specified in the ‘From’ field.

Tasks in the Job can be linked, so that clips are passed from one task to the next automatically (see next
sections).
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The different types of task available are:

Archive - backup files to either disk or LTFS tape. The Operation can be set to ‘Backup’, ‘Backup and
verify’, or ‘Verify’. ‘Backup and verify’ is recommended as this copies the files to the destination and then
reads them back, performing an md>5 verification against the source files. The ‘Add other files’ option allows
you to choose another folder of files to be included with the archive - for example if you have master sound
files that also need to be archived. If no clips are selected in the Library, the ‘Add other files’ option can still
be used to allow archiving of general files. The Archive tasks writes image, audio, and metadata files to the
destination in the manufacturers preferred structure.

Audio Sync - sync the selected video clips with audio files based on timecode. If both video and

audio are selected in the Library, these files will be compared for sync. If only video clips are selected a
browser will be shown where the location of audio files can be chosen. If there is an ‘audio’ folder containing
BWEF files in the same location as the video clip folders, these files will be used by default. After using this
task, the sync can be checked and adjusted in Review.

Clone - make a copy of the original clips from camera media to attached storage or a Transfer
Drive in Vault S/XL-Series. An internal CRC32 verification is performed as files are copied. The Clone
task writes image, audio, and metadata, and the copied clips are immediately linked back to the Library.

Generate - output files using one of the defined Deliverables. Typically this task is used to create files for
dailies, editorial, and VFX.

Import - import clips to Codex media.

Media Check - get a summary of the selected media (number of clips, frames, clip format). Also this task
can be used to apply Project metadata information such as ‘Production name’ and ‘Director’ to clips (from
Project->Setup), and to automatically set a Source Aperture (region of interest) to be applied to the clip
based on the Cameras that have been defined.

Media Verify - verify that no corruption has occurred to clips, and that they still match with the original
checksums. This is not needed as part of a normal workflow, but can be used if the software reports a CRC
error during another task.

Media Clear - format Codex media.

Media Sign Off - mark Codex media as ‘signed-off’, which means you have finished working with it and it is
safe to delete the contents using the Media Clear task.

Match Look - part of the workflow with Codex Live software. Looks saved when using Codex Live can be
matched to clips using this task. Timecode is used to match a look to a clip.

Link - add files to the Library without making a copy of them. When this job is started a file browser is
shown where you can pick a source folder containing clips you want to link to the Library. When linking to
ARRIRAW, VRAW, or Canon RAW material in the ‘default’ structure then image and audio files will
automatically be associated. If a Clone task is used the copied clips are automatically added to the Library.

Reports - save PDF reports for the selected clips. There are 2 types of PDF report that can be saved. The
Clip Report contains a summary of details for every selected clip. The QC Report contains details of any QC
points applied to clips using Review. Each report has a record of Production Name and Shoot Date.

This metadata must be added to the clips in order to appear in the report.

Each Job can be configured with a ‘From’ setting (the source where the clips are coming from) and/or a ‘To’
setting (the destination where the clips/files are going to). The ‘From’ setting is optional - if the template does
not have a pre-configured ‘From’ setting (that is, it contains the default ‘<enter input expression>’) then the
selection in the Library will be used, or if there is no Library selection you will be asked to select the source
when the Job is started.

Next to the ‘From’ and ‘To’ settings click the “..." button to open a chooser where you can pick the source/
destination for the Job. The options that specify ‘any’ (e.g. ‘Any SxS’) mean that the system will use any
connected media reader/port of that type. In the ‘Common Expressions’ options, choose ‘Any directory’ to be
able to pick from any source/destination folder on the system when the job starts.
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When setting up the ‘From’ and ‘To’ expressions as described in the section above, there is a ‘Common
Expressions’ set with options to link tasks within the same job together to use the same clips:

Select an expression to add Any Port or Directory

Third Party Ports Only If Media Is Empty

-
-

Common Expressions First task source

Cancel Previous task source

Previous task output

None

The options for this are:

+ First task source - use the same clips that were selected as the source for the first task in the Job.

« Previous task source - use the same clips that were selected as the source for the previous task in the
Job.

« Previous task output - use the same clips that were the output of the previous task in the Job.

The image below shows a Job that contains a Clone followed by an Archive. The Archive is set up using the
‘Previous task output’ option, to use the clips that were the output of the Clone:

Eelnl {MediaPort} = "*" -
i} {MediaPort} = "*" -

Eject Output Run after

=]l {Selection} = {PreviousTaskQutput} -

CODEX USER GUIDE - 10.11.2017




The table below provides details of the ports/readers that are supported, and which expression to use:

Category

Name In Vault Platform

Mac OS X reader

Vault S-Series port

Vault XL-Series port

Internal Ports Codex INT 1 NA 8TB Fixed Internal Storage, NA

module 1

Codex INT 2 NA 8TB Fixed Internal Storage, NA
module 2

Any Codex INT NA 8TB Fixed Internal Storage, any NA
module

Codex TD 1 NA Transfer Drive (removable) module Transfer Drive (removable) module 1
1

Codex TD 2 NA Transfer Drive (removable) module NA
2

Any Codex TD NA Transfer Drive (removable) any Transfer Drive (removable) any module
module

Any Codex INT or Codex TD NA 8TB Fixed/Transfer Drive, any 8TB Fixed/Transfer Drive, any module
module

Codex Ports Codex CD2 NA Capture Drive 2.0 Port Capture Drive 2.0 Port

Codex CD1 - Port 1 NA Capture Drive Port - CODEX 1 NA

Codex CD1 - Port 2 NA Capture Drive Port - CODEX 2 NA

Codex CD1 - Port 3 NA Capture Drive Port - CODEX 3 NA

Codex CD1 - Port 4 NA Capture Drive Port - CODEX 4 NA

Any Codex CD1 - Port NA Any Capture Drive Port NA

Codex OB NA Onboard Data Pack Port NA

Codex CD1 - SAS Port 1

Capture Drive Dock (SAS)
Port 1

Capture Drive Dock (SAS) Port 1

Capture Drive Dock (SAS) Port 1

Codex CD1 - SAS Port 2

Capture Drive Dock (SAS)
Port 2

Capture Drive Dock (SAS) Port 2

Capture Drive Dock (SAS) Port 2

Any Codex CD1 - SAS Port

Any Capture Drive Dock
(SAS) Port

Any Capture Drive Dock (SAS) Port

Any Capture Drive Dock (SAS) Port

Codex OB - SAS

Desktop Transfer Station
(SAS)

Desktop Transfer Station (SAS)

Desktop Transfer Station (SAS)

Codex CD1 - USB Capture Drive Dock (USB-3) NA NA
Codex CD1-TB Capture Drive Dock (TB) NA NA
Codex CD2 - TB Capture Drive 2.0 Dock (TB) NA NA
Third Party Ports AXSM 1 Sony AXS-CR1 AXSM 1 port NA
AXSM 2 Sony AXS-CR1 AXSM 2 port NA
Any AXSM Sony AXS-CR1 Any AXSM port NA
RED 1 REDSTATION - REDMAG, RED port 1 NA
REDMAG MINI, RED
MINIMAG
RED 2 REDSTATION - REDMAG, RED port 2 NA
REDMAG MINI, RED
MINIMAG
Any RED REDSTATION - REDMAG, Any RED port or RED STATION NA
REDMAG MINI, RED
MINIMAG
SxS 1 Sony SBAC-US30, Sony SxS port 1 NA
SBAC-UT100
SxS 2 Sony SBAC-US30, Sony SxS port 2 NA
SBAC-UT100
Any SxS Sony SBAC-US30, Sony Any SxS port NA
SBAC-UT100
Any Cfast Codex Cfast 2.0 Reader Codex Cfast 2.0 Reader NA
Any P2 Panasonic AU-XPD1 NA NA
SR Memory 1 NA SR Memory port 1 NA
SR Memory 2 NA SR Memory port 2 NA
Any SR Memory NA Any SR Memory port NA

When there is more than one task in the Job template, the ‘Run after’ settings control the order of tasks. The
default is that a task will run after the previous task, but this setting can be used to change the order, and
allows tasks to be run in parallel. For example, set tasks to ‘Run after: None’ and they will all start at the same

time.
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Operation:

+ Backup - files will be written to disk or tape (depending on other settings), and md5 checksums will be
created. After files are written they will not be read back and verified.

+ Backup and verify - files will be written to disk or tape (depending on other settings), and md5 checksums
will be created. After files are written they will be read back and verified against the source files.

+ Verify - files will be read back and verified against the md5 checksums created when the archive was first
written.

Archive name prefix:

+ Default - when the archive is created, the Default name for the top level folder includes a unique time and
date stamp in the format ‘archive_YYYYMMDD_HHMMSS_<archive_name>’, where the <archive_name>
can either be auto or manual, as described below.

* None - the ‘archive_YYYYMMDD_HHMMSS_’ details are not included, so the name of the top level folder is
based only on the name entered by the user.

Auto naming:

+ No - when the archive is started the user will be prompted to enter a name. This would typically
summarise the contents of the archive, e.g. ‘Day-56’, or ‘Rolls-A001-A002-B001’. When the archive is
written the files are contained in a top level folder that is named in the format: archive_YYYYMMDD_
HHMMSS_<archive_name>. For example, if the archive name was entered as ‘Day-56’, the archive name
could be: ‘archive_20160505_160142_Day-56’.

+ Yes - when this setting is selected an additional option is shown for ‘Auto name prefix’. In this field
enter a name that will be applied to each archive. This can be used to reduce the amount of information
the user is prompted to enter at the beginning of the archive. Each time an archive is run, a number
will be appended to the end. For example, if ‘Auto name prefix’ is entered as ‘my-project’ then archive
names could be: ‘archive_20160505_160142_my-project’, ‘archive_20160505_192133_my-project(2)’,
‘archive_20160506_094712_my-project(3)’.

Number of LTFS archives - this sets the number of tapes that will be written to during the archive. Options are
0, 1, or 2. If the tapes are not already formatted, they will be formatted with an LTFS (Linear Tape File System)
at the beginning of the archive.

Number of disk archives - this sets the number of disks that will be written to during the archive. Options are
0, 1,or2.

Predefine file path:
+ No - when this setting is selected the user will be prompted to enter the file path (disk location) at the

beginning of the archive.

+ Yes - when this setting is selected an additional option is shown for ‘Destination file path’. Click the ...’
symbol to choose the file path (location) of the disk to be used for the archive. This can be useful if you
always want to archive files to the same location.

Auto destination name:

+ No - when this setting is selected the user will be prompted to enter a name for the disk location at the
beginning of the archive. This name is logged by the system for tracking purposes.

+ Yes - when this setting is selected an additional option is shown for ‘Destination media name’. In this
field enter a name for the disk that will be used for the archive. This can be used to reduce the amount of
information the user is prompted to enter at the beginning of the archive.

Frame rate - by default files will be archived at the Original frame rate, and this is the recommended setting.
If required the files can be forced to a different frame rate in the archive. This option will affect only files stored
on media formatted with a Codex File System.
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Add other files:

No - when this setting is selected no other files will be included in the archive other than those clips selected
in the Library.

Yes - when this setting is selected an additional option is shown for ‘Other files location’. Click the "...’
symbol to choose the file path (location) of the other files to be included in the archive, or leave blank to set
the path when the Archive is started. This can be useful if you want to archive some files that cannot be
loaded into the Library - for example PDF reports, or camera sheet scans.

Matching rule:

Timecode only - video and audio clips will be matched if there is a minimum 30% timecode overlap.

Timecode and roll - video and audio clips will be matched if there is a minimum 30% timecode overlap and
the roll metadata also matches.

Auto name matching group:

Automatic - when the Audio Sync task is run, a group will automatically be created for video clips that were
successfully sync’d. When this setting is used the group will be named automatically in the format: ‘Audio
Sync YYYY/MM/DD HH:MM:SS'.

Manual - when this setting is selected an additional option is shown for ‘Matching name prefix’. In this field
enter an alternate prefix for the name of the group created of clips that have been sync’d successfully.

Create group for failures:

No - for any video clips that could not be sync’d to audio clips, no group will be created by default.

Yes - when this setting is selected a group will be created for video clips that could not be sync’d to
audio clips. The group of clips will be named automatically in the format: ‘Audio Sync Failures YYYY/MM/DD
HH:MM:SS’.

Auto name fail group:

Automatic - when ‘Create group for failures’ is set to Yes, the group created will default to the name format
detailed above.

Manual - when this setting is selected an additional option is shown for ‘Fail name prefix’. In this field enter
an alternate prefix for the name of the group created of clips that could not be sync’d.

Video clip metadata:

Keep original - when this setting is selected, no metadata will be extracted from the audio clips and applied
to the video clips.

Copy from audio file - when this setting is selected the following metadata items can be highlighted to be
extracted from the audio clips and applied to the video clips during the sync process: Scene, Take, Shoot
Date, Audio Track Names, Creation Time.

The Clone task does not have any settings, and requires only a From and To expression to determine the
source and destination. Clips are copied from camera media to attached storage or an 8TB Transfer Drive in
Vault S/XL-Series. An internal CRC32 verification is performed as files are copied. The Clone task writes image,
audio, and metadata, and the copied clips are immediately linked back to the Library.
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Deliverable - this can be set to ‘Specify at launch’, or to a specific Deliverable that is configured. When set
to ‘Specify at launch’, upon starting the Generate task the user can choose the Deliverable. When set to a
specific Deliverable the Generate task will always transcode to that format.

Predefine directory:
+ No - when this setting is selected, the user will be prompted to choose the destination for the Generate task
when it is started.

+ Yes - when this setting is selected an additional ‘Directory’ option is shown. Click the ‘... button to choose a
destination for the Generate task. This can be useful if you always want to write files to the same destination.

Base directory - this setting determines the folders that will be created above the files that are generated.
There are five options, depending on which file type is being created:
« {Roll} - this setting is suitable for stream file types, such as ProRes mov or DNxHD mxf.

+ {Roll}/{Shot} - this setting is suitable for sequence file types, such as dpx or exr.

« {ProductionName}/{ShootDate}/{Day}/Roll} - this setting is suitable for stream file types, such as ProRes
mov or DNxHD mxf.

« {ProductionName}/{ShootDate}/{Day}/{Roll}/{Shot} - this setting is suitable for sequence file types, such
as dpx or exr.

+ None - this setting will result in no additional folders being created inside the primary folder for the
Deliverables.

Video filename:

« Default - when this setting is selected, files created will use the clip name as shown in the Llbrary. For
files that require a sequence number (e.g. dpx or exr), the numbering will be based on the timecode of each
frame, expressed as ‘frames-since-midnight’. One exception is rmf (Canon RAW) files, that use ‘frame-in-
clip’ numbering.

« Custom - when this setting is selected an additional option is shown for ‘Custom video filename’. In this field
enter tokens or the name of a metadata property in braces to determine how the files will be named. There
are full details on the standard tokens and metadata property names later in this guide.

Stereo filename - this setting works in the same way as ‘Video filename’ detailed above, but applies only to
clips that contain 2 video channels, captured on either a Codex Onboard Recorder or Codex Action Cam.

Audio filename - this setting works in the same way as ‘Video filename’ detailed above, but applies only to
audio files that are created.

Source frames:

+  Whole clip - generate a file using all frames from the source clip.

« In-Out points - generate a file from the In point to the Out point of a clip. The In/Out points are set in
Review.

+ Custom - generate a file from a specified ‘First frame’. Set a ‘Number of frames’ to generate from the first
frame, or leave at the ‘All’ setting to generate to the end of the clip. This can be useful during testing/prep
to create smaller files, or shorter file sequences.

Render type:

« Per Clip - generate separate files/folders for each source clip.

+ Combined Clips - generate a single file/folder that includes all source clips. This may also be referred to
as a ‘group render’ or ‘timeline render’.

Eject external media:
« Prompt - when this setting is selected the user will be prompted as to whether they would like to eject the
target disk at the end of the Generate task.

+ Yes - when this setting is selected the target disk will be ejected automatically at the end of the Generate
task.

+ No - when this setting is selected the target disk will not be ejected at the end of the Generate task.
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Create ALE:
« Yes - when this setting is selected an ALE will be created for the selected clips along with the primary
Deliverable.

+ No - when this setting is selected an ALE will not be created alongside the primary Deliverable.

Source:

+ File - when this setting is selected files will be imported from a disk storage location. The import process will
search recursively through directory trees to identify any files that can be imported. Files will be imported to
Codex media based on the input expression in the ‘To’ field.

+ Tape - when this setting is selected files will be imported from LTFS tape. The tape must contain files written
using the Archive task. Tapes written with other methods cannot be imported. Files will be imported to
Codex media based on the input expression in the ‘To’ field.

Number of frames - by default all frames of a clip will be imported. This setting can be used to limit the
number of frames that will be imported for each clip.

Predefine file path:
« No - when this setting is selected the user will be prompted to enter the source file path (disk location) at the
beginning of the import.

+ Yes - when this setting is selected an additional option is shown for ‘File path’. Click the *..." symbol to
choose the source file path (location). This can be useful if you always want to import files from the same
location.

Predefine file path:
+ No - when this setting is selected the user will be prompted to enter the path (disk location) for files to link to
at the beginning of the Link task.

+ Yes - when this setting is selected an additional option is shown for ‘File path’. Click the *...” symbol to
choose the source file path (location). This can be useful if you always want to link to files from the same
location.

Recursive:
+ Yes - when this setting is selected the Link task will search down from the specified location into all sub-
directories to identify files that can be linked to.

+ No - when this setting is selected the Link task will only check the specified directory to identify files that can
be linked to.

Apply ALE after link:

+ Yes - when this setting is selected the Link task will search for an ALE associated to the clips being linked,
and apply metadata from this. The location of the ALE is expected to be inside the folder selected for the
Link - this is the location where the ALE is created if the files were produced by the Generate task.

* No - when this setting is selected the Link task will not search for an ALE associated to the clips being
linked.
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Create CRC32 samples:
- Disable - when this setting is selected, the Media Verify will not add checksums to files on media formatted
with a Codex file system.

« Enable - when this setting is selected, the Media Verify will add checksums to files on media formatted with
a Codex file system.

Repair CRC32 samples:
- Disable - when this setting is selected, the Media Verify will not repair any checksums that are detected as
incorrect for the source data.

+ Enable - when this setting is selected, the Media Verify will repair any checksums that are detected as
incorrect for the source data.

Create new volume:
+ No - when this setting is selected, a new Roll will not be created on Codex media as part of the Media Clear
task.

+ Yes - when this setting is selected, a new Roll will be created on Codex media as part of the Media Clear
task.

User sets new label:

+ No - when this setting is selected, a new Roll number will be automatically assigned to the media,
incremented from the previous Roll number.

+ Yes - when this setting is selected, the user will be prompted to enter a new Roll number during the task.

Default report directory - click the ‘... button to choose a destination for saving reports. This can be useful if
you always want to save reports to the same destination. If this field is left blank the user will be prompted to
choose a destination when the Reports task is run.
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[ NON ) Vault Platform

Project > VFS

@ Setup Cameras Framing Deliverables

Enable VFS Disable VFS . . .
Configuration name Camera negative

VFS Configurations f‘

@ Camera negative “ Parent directory /

Global filter *
Filename case Upper and lower
Deliverables
Camera negative
Path <Fixed Directory>

Filter

The VFS (Virtual File System) screen is where you set up the file types available from the ‘Codex VFS'. On Mac
OS X the ‘Codex VFS’ is a drive that appears on the Desktop. On Vault S/XL-Series the ‘codexvfs’ is a network
shared folder, accessible via Samba and NFS.

The VFS provides another way to access master files and perform transcodes. Once the VFS is configured
then clips are always available in the ‘Codex VFS' drive, ready to be copied. The system only performs the
transcoding when the files are copied, but the size of the files can be checked in the VFS prior to copying.

The default setting uses the ‘Camera Negative’ file type, and provides the source material in the original format.
For example, ARRIRAW material will be provided as .ari files, VariCam 35 material will be provided as .vrw
files, Codex Action Cam material will be provided as .cdx files.

There are alternate presets available for ProRes 4K, ProRes 2K, and DNxHD file types. To enable a different
preset click ‘Disable VFS’, then select the radio button next to the configuration name, then click ‘Enable VFS’.

Click the + icon to Add a VFS Configuration. Enter a descriptive Configuration name and then click the circle
icon next to a Deliverable to add it. You can have more than one Deliverable active in a VFS Configuration.

The Parent directory and Global filter settings can be left at their defaults. This will not add any additional top
level directories (for all file types), and will mean all clips on the system are available through the VFS.

To add a top level directory enter the details in the Parent directory field. This could be a text string, or a
metadata property name, e.g.

Parent directory - /MyProject/Deliverables/
Parent directory - /{ProductionName}/{ShootDate}/
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A full list of metadata property names is available in the later section ‘Metadata Property Names and Labels’.
The Global filter can also be set using metadata property names, e.g.

Global filter - {OriginalRoll} = “A001”
Global filter - {ProductionName} = “MyProject”

The Path for each Deliverable must be set correctly for files to be presented in the ‘Codex VFS’ drive.
The recommended setting for image sequences such as .ari, .dpx, .cdx is:

{ri/{s}/{s}.{g%7}.{e}

This gives a filename of /<Roll>/<Clip>/<Clip>.<FrameNumber>.<Extension>

The recommended setting for stream files such as .mov and .mxf is:

{ri/{s}.{e}

This gives a filename of /<Roll>/<Clip>.<Extension>

Click ‘Enable VFS’ and click the circle next to the Configuration name to make the files available in the ‘Codex
VFS’ drive. The image below shows a VFS Configuration for ProRes 422 LT and DPX:

000 Vault Platform o
Project > VFS 15:21:49 o

@ Setup Cameras Framing Deliverables Jobs

Configuration name ProRes 422 LT and DPX

VFS Configurations y
O Camera Negative Parent directory /

@® ProRes 422 LT and DPX '\ Global filter *

Filename case Upper and lower
Deliverables
ProRes 422 LT (2048x1080)
Path <Roll>/<Shot>.<Extension>
Filter
DPX 10-bit RGB (4096x2160)
Path <Roll>/<Shot>/<Shot>.<Tc frames>.<Extension>

Filter

For a full list of VFS tokens please refer to the later section 12 ‘Custom file naming in the Generate task and
VFS’
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[ JOX ) Vault Platform

Job Queue > Queue

Clear Completed Alerts

Job: Generate ProRes 422LT (preset)
Task: Generate - Input: Selection (35)

Status: Generated 3 clips successfully

Task: Archive - Input: Selection (36)

Status: Prepping...

The Job Queue screen shows the progress of jobs that are running. Jobs can be paused and stopped with the
buttons as required. If user input is required, for example to choose the target directory, then an Alert will be
shown. The Job Queue displays when a task has completed, or information if any errors occur during a task.
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[ JOX ) Vault Platform

Last licence update: 8 Dec 2016 2:09:44pm

Preferences > System

Feature Licensing

Dock Key: 3fc3-bd47-c1df-7641-8eda (USB dock)

Licensed features: Basic VFS, Vault

Licence expires: 22 Dec 2016

Media History

Clear:

Logging

[S%eloladllolsHll Default level -
Library

MEVATNiitelgMll | aunch Vault Review -
Screensaver

Lock screen: minutes

The System screen provides the following areas:

+ Feature Licensing - shows the hardware key required by Codex to generate a licence for the system) and
details of features licensed on the machine.

+ Media History - allows you to ‘Clear Media History’. This is advised before the start of a new project, as the
system keeps a record of Roll names and will present warnings if duplicate Roll names are detected.

+ Logging - allows you to save log files from the machine to provide to Codex Support. Default level should
generally be used - Full level should be provided in the event of issues with the Archive task.

+ Library - allows you to set the behaviour of the Play button that is shown on the focused thumbnail in the
Library.

« Screensaver - allows you to set a time for automatic logout from Vault Platform if there is no activity.
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[ JOX ) Vault Platform

System About

Current user: ..‘* MacBook-Pro 's

Preferences > Users

User List

You are connected to an 0SX machine. On this platform multiple user accounts are not supported.

The Users screen shows a list of the user accounts for the Codex Production Suite software. You can edit
details for the user account, and set a password to restrict access.

Click the pencil icon next to a user name to modify details and set the password.

The About screen displays information about the installed software version, and also displays licence
agreements for third party libraries used by the software.

Press Ctrl-H to view keyboard shortcuts. These can be used to quickly and easily move between the main
screens of the Vault Platform User Interface:

Ctrl + F (OS X) - Toggle fullscreen mode
Ctrl + T (S-Series) - Toggle touch-screen mode, to show mouse cursor and hide on-screen keyboard

Cmd + 1 (OS X), Ctrl + 1 (S/XL-Series) - Go to the Project view
Cmd + 2 (OS X), Ctrl + 2 (S/XL-Series) - Go to the Library view
Cmd + 3 (OS X), Ctrl + 3 (S/XL-Series) - Go to the Storage view
Cmd + 4 (OS X), Ctrl + 4 (S/XL-Series) - Go to the Job Queue view
Cmd + 5 (OS X), Ctrl + 5 (S/XL-Series) - Go to the Preferences view
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The following source camera formats and codecs can be used with Production Suite:

e ARRI ALEXA Classic/XT/SXT/Mini - ARRIRAW (16:9, 4.3, Open Gate), all ProRes variants.
e ARRI AMIRA - all ProRes variants.

e Panasonic VariCam 35 - VRAW (UHD and 4K, 10-bit and 12-bit).

e Canon C500 - Canon Cinema RAW (UHD and 4K).

e Canon C300 Mark Il - XF-AVC MXF.

e Sony EX3 - MPEG-2 MXF.

e Sony F5, F55, and F65 - Sony RAW MXF, XAVC MXF.

e GoPro Hero - H.264.

e RED - REDCODE RAW R3D.

e Phantom Flex 4K - Cine files.

The following audio file formats can be used with Production Suite:

e WAV and Broadcast WAV
e 1to 18 channels
e 48kHz and 96kHz

For custom file naming in deliverables, any metadata field (such as Roll, Scene, Take) can be referred to by
using the property name of the field enclosed in {braces} — for example {Scene}. Metadata fields used in this
way are called tokens.

When the deliverable file is created, these tokens are then replaced by the value of that field from the source
clip. For example, a custom file name could be:

{Scene}-{Take}

Then for each clip the tokens will be replaced by the Scene and Take values. If the clip metadata has a Scene
value of 14 and a Take value of 5, the deliverable file name would be:

14-5

Deliverable files also need a file type extension, for which the {e} token should be used. With a custom file
name of {Scene}-{Take}.{e}, the deliverable files would be named with the correct extension, for example:

DPX: 14-5.dpx
MOV: 14-5.mov

All metadata is described by internal property names, which are ultimately what the token-replacement system
uses: the built-in ones are listed in the section ‘Metadata Property Names and Labels’ and have to be case-
sensitive and without spaces. Examples are ProductionName and CircleTake.

However, the user interface presents metadata fields with ‘friendly’ names for improved readability. These
names are not case-sensitive and may contain spaces.

It is possible to modify the metadata views, such as Filecard or Project, if you need to add your own custom
fields. Users wanting to perform such customisation should contact support@codex.online for further details.
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There are also a number of single-letter tokens. Some of these are for convenience - for example {r} is the
same as {OriginalRoll} — but they are mainly for special purposes when setting up custom file naming. For
example, if you are generating dpx files - which are one-per-frame - {f} can be used to put the frame-number in
each filename. There is a full list of all legal token-names in ‘Metadata Property Names and Labels’.

User Friendly Label

Metadata Property Name

Synonym

Production ProductionName
Production Company ProductionCompany
Unit ProductionUnit
Director Director

DoP DirectorOfPhotography
Camera Assistant CameraAssistant
Codex Operator CodexOperator
Sound Recordist SoundRecordist
Name ShotName {s}
Roll OriginalRoll {r}
Scene Scene

Take Take

Shot Shot

Slate Slate

Circle Take CircleTake

Shot Type ShotType

Interior / Exterior IntExt

Day / Night DayNight
Comments Comments

T-Stop Tstop

Focus Focus

Lens LensType

Filter Filter

Source Type SourceType

Source ID Sourceld

Source Name SourceDevice

Serial No SourceSerial

Shutter Angle ShutterAngle
Snapshot Snapshot

Date Date

CDLData CDLData
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Clip name

Roll name

Clip recording date (which is not the same as using the {ShootDate} token)
Clip recording date and time

Frame number

Extension (file type)

Channel number (Video and Audio)

Channel ID, from Channelld_V1 and Channelld_V2 metadata

Timecode (as hhmmssff string)

Start timecode of clip

Timecode (as frame count from midnight)

Start timecode (as frame count from midnight}

Total number of frames in the clip

Userbit per frame

Start userbit for clip

Port description (i.e. where media is loaded)

Media GUID (unique hardware ID)

Source Width

Source Height

Clip uuid (128-bit unique identifier of every shot — XXXXXXXX-XXXX-XXXX-XXXXXXXXXXXXXXXX)

088=Te=

ﬂ_ﬂ_ﬁﬁﬁﬂ_ﬂ_“““““““““““““
S=s=T"mwWos o 9=

C

Tokens can optionally have a minimum and/or maximum width specified for the expansion. This is most
commonly used with tokens that produce numbers, but work with any single-letter token.

To specify a minimum width n add %n after the token. To specify a maximum width n, add -n after the token
Examples:

f} Frame number 0-99999

f%5} Frame number 00000 — 99999

{
{
{r}  Roll (A long name”)
{r-8} Roll (A long n”)
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Review allows you to playback any clips from your Production Suite Library, as well as perform primary colour
correction for dailies, audio synchronisation, QC of images, and export of colour corrected stills. Looks are
applied non-destructively and can be saved to the Look Library to be applied to other clips. Review supports
CDL and a range of 3D LUT formats created in other applications.

Review can run on Mac, Vault S-Series (with Review module) and Vault XL-Series.
The software can be controlled with a keyboard and mouse, with a range of keyboard shortcuts available.

It integrates with the Tangent Element series, Tangent Ripple, or Tangent Wave panels. (Tangent drivers must
be installed separately on Mac.)

For video output from Mac Pro or MacBook Pro, Review can be used with:

e AJA 04K can be used to output via SDI or HDMI, from HD up to 4K resolutions.
e AJA T-Tap can be used to output via SDI, from HD up to 2K resolutions.

In order to use an AJA lo4K for HDMI/SDI output, or AJA T-Tap for SDI output, you will need to install the
device drivers available on the AJA website.
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To launch, select the clips in the Library, then click ‘Open In Review’ in the Tools panel.

Library Codexs-MacBook-Pro.local Ready
= — - + O 6ot =, E. selected12 o c
1-37_AA002 o 1-18_AA002 ® 1-19_AA002 VAN EE
3 79
o . Group from Selection
=1 > Delete Selected Clips

1-10_AA00T 1-17_AA001 @ 1-52_AA003 CreateALE
y Py ’ .
# £ AL :
Oy NG : _ 1 <
f - . Resync Linked Clips

= ;

1-25_AA002 - A001C003 fod  Archive to 2 disks (preset)

T — X 1 Q Clone (preset)
ey : ® - \ 4

-, < fo) Link to Clips (preset)
gl | Eod Generate any Deliverable (preset)

Other Jobs

test04

Review allows playback of any clips loaded in the Library. It can be used for primary colour correction and
for saving Looks. QC Marks can be added to any of your clips. Audio clips from the Library can be synced
with any of your loaded video clips. Playback can be viewed from the Vault S-Series/XL-Series GPU and SDI
outputs, directly on your Mac, or to an external monitor via SDI using an AJA 104K or T-Tap.

There are a variety of options available via keyboard shortcuts, or via the top menu bar on Mac when Review is
in window mode. Use Cmd + F on Mac to toggle between full screen and window mode.

Ctrl + Alt + S (or top menu bar Misc -> Edit Shortcuts) will bring up the shortcut editor allowing you to view and
edit all available keyboard shortcuts.

Click the + icon next to a function to add a new shortcut. Click on an existing shortcut to reassign or remove it.
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The Configuration Options can be accessed by clicking the Blue Ring in the top left of screen. From this menu
you can choose an external SDI Output Device, set the playback frame rate, select your Audio device and
Audio Volume (Mac only).

Codex Blue Ring

Select Viewport

Select SDI

Output Aperture
Colour Space C = )

Processing
Sharpening
Sensitivity Controls
Export Type DPX/JPG =
Choose SDI ﬁ
Output Aperture

The output resolution can be set from the SDI menu. Once an SDI output device is successfully detected, then
options for Aperture, Link and Bit Depth will appear.

The Aperture setting allows you to add a Destination Aperture to your SDI Output. (Please see section 7.3
Framing for more information).

Use the Link dropdown menu to set the SDI output as a 3G 444, 3G 422, 1.5G Dual Link 444 or 1.5G Single
Link 422,

Bit Depth allows you to choose between a 10-bit or 12-bit SDI output signal.

Colour Space allows you to choose between Camera Native, ACES, ACEScc, or ACEScct as the working
colour space. The ACES options work with a selection of the file formats that can be used. If the software does
not have ACES support for a file format then it will always be displayed in the Camera Native colourspace
regardless of this setting.

Processing allows you to choose between quality settings to optimise playback for your hardware.

Sensitivity Controls include Printer Lights step (0.25 to 1) and Colour Ball sensitivity.

Export Type allows you to choose between JPG or DPX for exporting Stills (See section 14.8 Exporting Still
images) and set an Export Path to save the files to.

Sharpening allows you to view your images with an Unsharp Mark applied. Values are limited from 0 to 300. A
typical value for a creative application would be between 80 and 120.
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Next or

Previous Clip
Play Forwards Frame Step  Playback Playback Full Clips or  Play Single/Play All Clips Playhead Play Queue
or Backwards Forwards or  Speed within In/0ut Points
Backwards

Stop, Loop, Bounce

The transport controls are located at the bottom of the screen.

Clip selector - The Next or Previous Clip controls allow you to select which clip to playback, or simply click in
the centre of the control to select from a list of loaded clips.

Play Forwards or Backwards controls allow you to choose to play your clip forwards or backwards. Clicking
the control during playback will pause at the current frame.

Frame Step Forwards or Backwards allows you to step through frames one at a time.

Playback Speed allows you to choose between x0.5, x1.0, x.2.0, x3.0, x4.0 or x5.0 playback speeds.

Set playback of a Single clip or All of the currently loaded clips with the Play Single / Play All Clips control.
Clip Playback Behaviour - Stop, Loop or Bounce; Stop at end of clip(s), Bounce - play in reverse at end of
clip(s), Loop back to start at end of clip(s). This applies to the current clip only in Play Single mode or all clips
in Play All mode.

Playback Full Clips or Play within In/Out Points allows you to choose whether playback will play the entire
clip, or will be limited to the set In/Out Points for that clip. If a clip has no specific In/Out Point set, then this

option will play the entire clip.

The Play Queue is only visible when the A/B Timeline is shown, and allows you to quickly move to any point in
any clip by clicking with the mouse.
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Re-centre image
Fit Screen Options Show/Hide Overlays

‘‘‘‘‘‘‘‘‘‘

Marker Overlay [

Masked area
of image

Source
Aperture

Viewport Options allow you to specify how your viewport is fitted to the screen. Exactly which part of your
source image this applies to depends on your Fit Options setting.

+ Fill Screen sets your viewport to fill the screen with your image. This will fit either the x or y axis of your
image and crop the other, to ensure there is no blank space on your screen.

« Fit Screen ensures your entire image is displayed by either letterboxing (grey bars top and bottom of your
image) or pillarboxing (grey bars left and right of your image).

+ Avail Space fits your viewport to the available space inside any open panels. For example if you have
chosen to show the Colour Controls, then your viewport will fit the remaining space above the Colour
Controls.

Fit Options gives three fitting options, as well as allowing to enable zoom mode:

« Fit Src Aperture fits only the specified Source Aperture of an image into your viewport.

« Fit Src Apt + 5% fits only the specified Source Aperture of an image, plus and extra 5% lookaround, into
your viewport.

+ Fit Src Canvas fits the entire recorded image into your viewport.

+ 1x, 2x, and 4x enables Zoom mode and zooms to either 1x (1:1 pixels), 2x or 4x. Once you have enabled
one of these three modes, you can zoom in and out with the mouse scroll wheel or use keyboard
shortcuts listed below.

+ Re-centre sets the image centrally in the Viewport.

Keyboard shortcuts can be used for the Viewport and Fit Options:

oT Viewport Fill Screen

o shift+ T Avail Space

o = 1:1 Pixels (Zoom Mode)
0 + (shift =) zoom out

o _(shift-) zoomin
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By clicking the Overlays button in the top bar, you can toggle on/off overlays in your image, such as the basic
clip information in the corner of your image, and QC regions you have set.

The above diagram shows Playhead A Marker Overlay and Playhead B Marker Overlay. These overlays show
you the playhead that the image is loaded into (A or B), zoom level, the clip name, the current frame in the

clip and the timecode that the playhead is currently parked on - for example; [A] [25%] 1.9_AA001 42/202
20:39:03:03

Enabling or disabling Overlays will also show/hide any QC Region overlays.

The Timeline view shows events for the currently playing clip:

e |n/Out Points
e Notes
e QC Marks (see QC section later in this guide)
e Poster Frames
Show/Hide Timeline

A LA A

'y
.

rels )

Playback In Point Note Poster Frame  Set In Paint Navigate Notes Set Qut Point
Playback Out Point

Set Poster Frame - The Poster Frame for each clip can be selected by moving to your chosen frame and then
clicking Set Poster or using the P keyboard shortcut. A Poster Frame can be used to most easily identify your
clip. Once a Poster Frame is set, then this will become the Thumbnail in your Production Suite Library, and can
also be exported as a Still image (See section 13.8).

Notes - A Note is any frame in the clip you would like to easily navigate to. After setting a Note, use the Clips
view in Notes mode to show a list of all the Notes that are set, and click to quickly move between them.
These can also be exported as Still images (See section 14.8). At any point in a clip you can set a Note by
clicking Add Note. You have the option to name the Note in the box to right of Add Note, as well as move
between Notes by clicking the arrow icons. The “X” icon to right of this will delete a Note.

In/Out Points - Click Set In and Set Out to create In/Out Points for each clip.
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14.6.2 Group from Timeline

The ‘Group from Timeline’ button will create a group from the timeline in Review. Click the ‘Group from
Timeline’ button and enter a name for the group. Press the ‘Enter’ key and the group will be created.

The group can be accessed in Vault Platform from the Library->Group view, and used as the source for tasks
such as a Generate, which can render the clips into a single, combined file.

To change the order of clips on the timeline use the keyboard shortcut Cmd-Up or Cmd-Down (Ctrl-Up/Ctrl-
Down on XL and S Series) to move the current clip forwards or backwards on the timeline.

14.7 Glips

The Clips view allows you to navigate through your clips by clicking and scrubbing through the thumbnails.

Show/Hide Clip View

Clip View Mode
Export Stills

Playhead

e Toggle the Clip view on or off with the Clips icon at the top of the Review screen. The current position of the
Playhead is indicated by the red line.

e You can choose to display the Clip view as Clip (Poster Frames), QC marks, Notes (See
Poster Frames, In/Out Points and Notes section 14.6.1) or In/Out Points with the Clip View Mode control.

e (Click anywhere on your Clip View timeline to move your Playhead to that frame. You can also click and
drag your mouse left and right to scrub through your clips.

e Scene and take numbers are displayed in the bottom left of each clip.

14.8 Exporting Still Images

Still images for each clip can be exported, in 10-bit RGB dpx or jpg format (see section 14.2), by clicking the
Export Stills icon and selecting Stills. The Stills created will include any Looks that have been applied. The
type of Still image saved depends on which Clip View Mode you have selected (i.e. Clip (Poster Frames), QC
marks, In/Out Points or Notes). By default, these will be exported to a folder on your Desktop on OSX, or you
can specify an Export Path from the Review Main Menu.

CODEX USER GUIDE - CODEX PRODUCTION SUITE 46.0-04810 10.11.2017 PAGE 59



The default behaviour of Review is to show a single clip in a single Viewport (Playhead Options set to A and
Off). Review also supports a dual Viewport functionality which can display upto two simultaneous images from
the A, B, C and D playheads.

Playhead Options  Show/Hide A/B Playhead Timeline

Left Viewport Right Viewport

Select A/B
Playhead

A/B Timeline Playhead A Playhead B Playhead C Playhead D

You can add the A/B Playhead Timeline with the Show/Hide Playhead Timeline button. This allows you to
independently move each of the four playheads (A, B, C and D) to any point in the timeline for your selected
clips. To do this, click on the Select A/B Playhead options (A or B) and then select a point in the Timeline to
move your Playhead to.

To access playhead C and D in the A/B Timeline, you will need to select the option from View menu bar
dropdown, or set keyboard shortcuts for View Playhead C and View Playhead D.

Note: the position of Playhead A is indicated by a red line to the top of the A/B Timeline and that Playhead
B is indicated by an orange line to the bottom. Playhead C is indicated by a green line on top of the A/B
Timeline, and Playhead D by an orange line on the bottom.

You can choose how you would like to display your Playheads with the Playhead Options dropdown menus in
the top bar.
e To only view one Playhead across the whole screen, set one of them to A, B, C or D and the other to Off.

e Toview A, B, C or D side-by-side in left and right viewports, set the playhead options to display any of the
playheads.

e You can also choose to display one of your Look Stills in either the left or right pane by selecting Still, and
then opening the Looks side panel and choosing the Look you would like to display. See section 14.10.5
for more information on the Look Stills side panel.
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e By hovering your mouse in between the two images in the A/B Viewports, you will see a resize pointer
appear. By clicking and holding, and swiping your mouse left and right, you reveal more of less of each
image.

e When in 1x, 2x or 4x Zoom mode, you can hover your mouse over each Viewport and use your mouse scroll
wheel to zoom in and out of each image independently.

e Once zoomed out, you can click and hold on either image to reposition it anywhere on the screen.

Display the colour controls by clicking on Colour in the top bar. This panel allows you to non-destructively
add LUTs, and adjust CDL values using the colour wheels. The Colour Panel can be controlled by using the
Tangent Element, Wave or Ripple panels, or simply with your mouse or trackpad.

Review & nvailspace D [Fi] i ReB Timeline  |AIB| Colour |~ Clips  Audio | QcC

[A][32%] 1-37_AA002 143/211 00:08:24:09

P P

Review has a Meters panel that includes Histogram, Vectorscope, Parade and Waveform meters.

e Place your meters before or after your colour changes with the Pre/Post Colour options.

e Meter on only a specific region of your image by enabling the Region On/Off button and moving and
resizing the Meters Region Overlay.

e Adjust the sensitivity with the Sensitivity Sliders and boost the Vectorscope signal from 100% to 1600%
with the Vectorscope boost control.
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Show/Hide Colour controls ~ Show/Hide Meters

Pre-Post Colour

Region On/0ff
Histogram
Viectorscope
Msters Region
Overlay
Parade

Sensitivity slider

Waveform

Input LUT controls —' Printer Lights controls (DL controls

LUTs to be used should be copied to /Library/Application Support/Codex/luts on Mac OS X,
or /usr/share/codex/luts on Vault S-Series/XL-Series.

Input/Output LUTs - Click the Edit Icon at the bottom of the Input LUT or Output LUT selector boxes to

choose which LUT you would like to use as an Input or Output LUT. Input/Output LUTs are global across all
clips.

Pre and Post LUTs - These can be chosen by clicking the Edit Icon in the Pre LUT or Post LUT boxes. You
can also disable or enable these LUTs. These LUTs affect only the selected clip.

Click the Edit Icon on the right-most box (coloured blue) to toggle between Full / Legal Output.

Printer Lights ~ LGG/CDL Mode Select

Input LUT  Pre LUT  Colour controls Edit CDL Bypass control Saturation  Post LUT  Output LUT

Hide
controls

Gamma

oV

Toggle Full/
Legal Output

)
2
=)
=

V)

Printer Lights Density Reset All COL Reset Master Master ~ Colour Offset Edit Icon
Reset Colour Offset

The Printer Lights Colour Controls allow you to adjust Red, Green and Blue values with the up and down

arrows, and control density with the Printer Lights Density control. Click on any of the R, G or B values to
manually edit them.
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The Colour Wheels are used to adjust the colour of the clip. Any changes will be saved as CDL metadata
with that clip. CDL metadata can be exported as an ASC CDL or CCC xml file, which is compatible with other
applications.

There are two modes to select by clicking the LGG / CDL Mode Select icon to the left of the Colour Wheels:
Lift Gamma Gain (LGG) and Offset Power Slope (CDL).

In LGG and CDL modes, the values are controlled with Colour Wheels. You can apply a Colour Offset using
the dot inside the wheel, and control the magnitude of the effect with the grey semi-circular Master slider.
There are reset controls underneath the Colour Wheels. The left-hand reset will zero the master control, and the
right-hand reset will centre the colour offset. The Reset All CDL control is a master reset of all Colour Wheel
controls in your selected mode.

The Edit RGB icon at the top left of the Colour Wheels section switches the view to display RGB values for
each of the three wheels, and allows you to edit these values.

Saturation can be adjusted with the Sat slider and reset or bypassed with the buttons to the right.

Bank Looks - Press and hold any number key 1 to 6 to quickly bank a Look (all colour settings) into one of the
six banks. Press any number key 1 to 6 to paste the banked Look on the current clip.

Show/Hide Looks Panels 1 & 2 Show/Hide Live Look Panel
Looks Panel 2

Looks Panel 1

Saved
Look Still

Export
Look Data
Delete Look

Add
New Look

Edit Look Name ~ Sort Looks Apply Look to current Clip
Apply Look to all Clips loaded

There are two Look Panels (I and Il) which can be opened by clicking the Show / Hide Look Panels 1 and 2
buttons.

The Look Panels allow you to save, apply, and export Looks. A saved Look is comprised of Pre LUT, CDL
values, and Post LUT. (Note: the In and the Out LUTs are global settings in Review, and so will not be saved in
the Look file).
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e To save your colour changes as a Look, click the Add New Look button, choose Capture and you will see a
new Saved Look appear in your Looks Panels.

e You can also import a JPG or PNG file as a Look. Click the Add New Look button and choose Import.
e To delete a Look, select one or more (with Shift-click)in the Looks Panels, and click the Delete Look button.

e Edit the name of a Look by selecting it in the Looks panel and then clicking the Edit Look button. Click
the Edit Look button again to exit edit mode.

e Double clicking on a Look will apply it to the current clip. This can also be done with the Apply Look to
Current Clip button.

¢ By clicking Apply Look to All Clips, you will see a dropdown menu allowing you to choose if you would like
to apply the selected Look to all clips currently loaded, or to end of timeline - this will apply the Look to your
current clip and then all further clips until end of the timeline.

e You can use the search box at the top of the Looks Panel to search for a Look by name.
e Click Sort Looks to sort your Looks by Name, Scene, Take, Roll, Day or Creation date.

e Use Export Look Data allows you to export your Look data in several ways. Hold shift to select more than
one Look to export:

o ALE - exports your CDL data in ALE format. You may select multiple Looks to be contained within a single ALE.
0 CCC - exports your CDL data in CCC format. You may select multiple Looks to be contained within a single CCC file.

0o CDL - exports your CDL data as a CDL file. You may select multiple Looks which will be saved as
separate CDl files.

o Stills - exports still images of your looks in JPEG or DPX format (see 14.2 Configuration Options).

o Live - exports all Looks into a Codex Live Look XML that can be loaded into Codex Live on another computer.

Show/Hide CDL Panel

CDL Panel

Auto-match CDL
Sort List

Export CDL

Edit Name

Delste DL
Load CDL

Apply CDL to all Clips ~ Apply CDL to Current Clip
Review allows you to apply imported CDL values to your clips.

e Add a CDL file by clicking Load CDL. You can choose to load a CCC or CDL file.

e Use the additional tools to Sort List alpha-numerically, Export CDL files, Edit Name or Delete CDLs from
the CDL panel.

e Apply CDL to a single clip by double clicking, or using the Apply CDL to Current Clip or Apply CDL to all
Clips buttons.

CODEX USER GUIDE - 10.11.2017



e The Auto-match CDL feature enables you to auto apply any CDL files loaded into the CDL panel based
on Scene and Take metadata. To use this feature, you will need to edit the CDL file description to
include the Scene and Take. For example if Scene is 1 and Take is C012, edit your CDL file in a text editor
and adjust the description field like this:

<Description>1C012</Description>
Once you have edited your CDL file, load it into the CDL panel ready to Auto-match.

Colour can be adjusted in Review with the Tangent Element series of controllers (Tk, Mf, Kb and Bt). Once
connected the LCDs will indicate the parameters which can be adjusted with each of the controls. You can
switch between LGG, CDL and PL modes, adjust Master and Offset, bypass LUTs, and use Transport controls.

Here are some additional controls not listed on the LCD’s:

e Tangent Tk: Hold down A to toggle controls for Jog (to scrub through playback) and Saturation.
e Tangent Tk: Press B to cycle through LGG, CDL and PL modes.

e Tangent Mf: Hold down A to use the wheel as a Jog control, and set In / Out points, as well as switch view to
Red, Blue or Green colour channels.

e Tangent Mf: Press B to cycle through control of each of the three colour wheels in LGG and CDL modes, or
Red, Green, Blue in PL mode.

Click the Audio Side Panel icon to open the Audio side panel. Here you can select from any Audio clips that
are currently in the Library to sync with your Video clips.

Audio Side Panel Show/Hide Show/Hide Audio Timeline

Selected
audio clip
Audio
channels
for se]ectgd
audio clip Unused
Show only section of
matching audio clip
audio clips (Grey)
<> T ] i +] < B - | < B - ] B ) mmln Lo D00St
Fit whole
Synced section of  Audio Sync options Audio Timecode Position ~ Audio Sync Offset Audio clip zoom  audio clip
audio clip (black) Apply control into audio
timeline

e Click the Audio icon to Show / Hide the Audio Timeline at the bottom of the screen. This will show the
waveform of any audio that is synced to your video clip. The red line will indicate the current
position of the audio clip playhead on the waveform.

¢ The Audio Side Panel shows all audio clips currently linked to your Library. Any that match the timecode
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of your currently selected video clip will have a percentage value next to the audio clip name, for example
CODEX_011 [91%]. The percentage value is the amount of the audio clip that matches with the video clip
timecode. In the above example, the audio recording started before the video clip, and ended after it.

If your audio clip started and stopped at exactly the same time as your video clip (i.e. start and stop
timecodes values match), you will see the audio clip name appended as [100%].

e The [R] and [S] icons next to some audio clips indicate a match of Roll or Scene with the current video clip.

¢ |n the Audio Side Panel, select the audio clip that you wish to sync with your video clip. If there is a
timecode match (i.e. 91%), then the audio clip will be chosen and automatically synced with the video.

* The section of the audio clip that does not match the timecode of the video clip is shown with a grey
colour (Unused Section of Audio Clip), and the matched part of the audio clip is shown in black
(Synced Section of Audio Clip).

e At the bottom of the Audio Clip Library Side Panel, you will see the waveforms for the different channels
for your selected audio clip. In the example above, the audio clip has three channels. Click on each channel
to display that waveform in the Audio Timeline.

e Use the Fit icon to Fit the Whole Audio Clip Into Audio Timeline, or use the Audio Clip Zoom contols
to zoom in and out of the waveform in the Audio Timeline.

¢ Use the Waveform Boost function to boost the visual waveform by up to 6x.

e For manual Audio Sync, or if you wish to adjust the Audio Sync for any clips that have automatically synced
with timecode, Cmd-click (on Mac) or Ctrl-click (On Vault S/XL-Series) anywhere in the Audio Timeline to
move the red audio clip playhead to the desired position.

e Use the Audio Sync Offset controls for finer control of the sync. The + and - symbols will advance or move
back in quarter frame increments.

e The Audio Side Panel has further options for syncing your audio clips, available by clicking the
Audio Sync Options cog icon:

o Auto Match - Selects best audio clip from the displayed list, considering timecode and roll / scene / take metatdata.
o Auto Sync - Resets to audio offset of your current clip, so that audio and video timecode are in-sync.

o Reset - Discards the audio changes made since last save.

Click Show/Hide Metadata to open up the Metadata View side-panel. (see below) You can select different
views with the Choose Metadata View dropdown menu at the bottom of the side-panel.

Edit Scene and Take, and add comments, for each clip by clicking the Edit Mode button or using the E
keyboard shortcut. Use tab to move between Scene, Take and Comments and Enter to save changes for your
clip.

Click the Circle Take icon to set circle take metadata to Yes or No.
The Auto-increment Take button will apply a Take number for any clips with a matching Scene number, which
appear before your selected clip in the Timeline. For example if you have three clips in Review all marked as

Scene 1, pressing the Auto-increment Take button on the last clip will set your three clips as Take 1, Take 2
and Take 3.
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Show/Hide Metadata
Circle Take ~ Show/Hide Clip Changes window

Auto-increment

Take
Edit Mode
Clip 'é

Changes

window
Choose
Metadata
View

Any changes made in Review will be stored in your Clip Changes window. These will not be committed to
your clip until you click Save to save individual changes, Save All to globally save all changes, or until you exit
Review when all changes will be saved automatically. You can also use Cmd S at any time to globally save all
changes.

Click Discard to discard individual changes or Discard All to discard all your changes before you exit.

The QC Tools allow you to mark events in your timeline per clip, frame or range of frames, and then save them
as a QC Report.

e Click the QC button at the top of the screen to open the QC Toolbar:
e A QC mark can be for a single Frame, a Range of frames, or Global (all frames in the clip).
o Single Frame - Click Add In/Out to create a QC Mark on your current frame.

o Range - Click Add In/Out to create a QC Mark. Move your playhead to the end frame of your range and
click Set QC Out.

o Global - Click Add Global to create a QC Mark across your current clip.

e A QC mark will default to being for a Region. A red box is shown, and you can click and drag to re-position
and resize the Region. Unclick the circle next to Region if the QC mark applies to the whole image.

¢ (Click Predefined QC Mark Names dropdown to open a list of common issues, or click in the box to the left
to enter your own comment.

e After setting QC points on your clips, use the Reports task in Production Suite to create a QC report. To do
this, select all clips in the Vault Platform Library, start a PDF Reports job, choose where you would like to
save the pdf, and then select the QC Report button at the bottom of the screen.
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(C Toolbar On/0ff

(C Region
Overlay

Clips View
Mode set
to QC

Add QC Mark Delete QC Mark QC Region On/0ff Pre-defined QC Mark Names
(C Mark Selector (C Mark Range (C Mark Name QC Timeline
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NOTE: Keyboard shortcuts mapped to the Numpad should be checked due to regional keyboard differences.

¥ File
Save All
Export Current Frame
¥ Edit
Undo
Copy Look
Copy White Balance
Copy Colour
Paste
Paste To End Of Timeline
Apply Look From Previous Clip
Apply White Balance From Previous Clip

Apply Colour From Previous Clip

Bank Look A

Bank Look B

Bank Look C

Bank Look D

Bank Look E

Bank Look F

Edit Audia TC

Edit Audio Slip

Edit Scene/Take

Revert Te Original Colour

Revert To Madified Colour
¥ View

Grab Look Still |

Grab Look Still Il

Search Look Stills |

Search Look Stills ||

View Playhead &

View Playhead B

View Playhead C

View Playhead D

Wiew Playhead Still

Cycle Playheads

Viewport Available Space

Viewport Fit To Image

Viewport Fullscreen

Centre Image

Move SDI Split Screen Left

Mave SDI Split Screen Right

Move Clip Backwards

Move Clip Forwards

Zoom In

Zoom Out

Reset Zoom

Hide/Show OSD

Toeggle Menu
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command + 5

command * G

command + Z
c
ghift + C
shift + command + C
']

option = ¥
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]
rismpad 0
shift + command + 5

E

5
Fi12
shift+T
aption+ T
L
X

[

oomimannd + cursasr down
COMmmand + cursor up
shift + +

shift + _




Taoggle Looks |
Toggle Looks I
Toggle Live Looks
Toggle CDLs
Toggle Audio
Toggle Overlays
Toggle Timeline
Toggle [A|B
Toggle Colour
Toggle Clips
Toggle QC
Toggle Metadata

¥ Mark

Add Mote

P ET A

Mark Out

Set Poster Frame

¥ Playback

Play/Pause

Play Forward

Play Reverse

Pause

Step One Frame Forward
sStep One Frame Reverse
Mext Clip

Previous Clip

First Frame

Last Frame

Mext Marker

Previous Marker

Mext Poster Frame
Previous Poster Frame
GoToln

Go To Qut

¥ Colour

Reseat All

Edit CDL

Bypass White Balance
Bypass Input LUT
Bypass Pre LUT
Bypass CDL

Bypass Post LUT
Bypass Output LUT

Bypass All

Printer Red Increase
Printer Red Decrease
Printer Green Increage

Printer Green Decrease
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cursar right
cursor left
CAFE Lp
CUrsor down
home
end
shiff + cursor up

shift + cursor down

shift + |

shift#= 0

command + 1
command + 2
command + 3
command + 4
command + 5
command + &
command + 7
command + 8
command + 9
#7139
nurmpad 7
£30030

numpad 8




Printer Blue Increase numpad /
Printer Blue Decrease numpad 9
Printer Cyan Decrease numpad 1

Printer Cyan Increase numpad 4

Printer Magenta Decrease numpad 2
Printer Magenta Increase numpad 5
Printer Yellow Decrease numpad 3
Printer Yellow Increase numpad &
Printer Density Increase Aumpad +
Printer Density Decrease returm
White Balance Increase
White Balance Decrease
Tint Increase
Tint Decrease
Exposure Increase
Exposure Decreage
¥ Audio
Slip Audio Quarter Frame Forward option + command + cursar right
Slip Audio Quarter Frame Reverse optien + command + cursor left
Slip Audio One Frame Forward command + cursor right
Slip Audio One Frame Reverse command + cursar lefi
Slip Audio Ten Frames Forward cirl + optian + command + cursor right
Slip Audio Ten Frames Reverse ctrl + aption + command + curscr left
¥ Misc
Edit Shortcuts cirl = option + 3
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